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1 Introduction

Lorsqu’on fait des expériences, les données expérimentales obtenues sont aujourd’hui représen-
tées, analysées et modélisées à l’aide de tableurs comme Excel, Kaleidagraph, EasyPlot...
ou de logiciels de calcul scientifique comme par exemple Matlab. Nous vous proposons d’utiliser
un logiciel intermédiaire entre ces deux types de fonctionnalités : Igor1. Il permet d’exploiter
des données, de les représenter et d’en faire une analyse statistique à travers des options de
smoothing2, de curve fitting3 ou de transformée de Fourier.

Ce logiciel peut également être enrichi par des fonctions ou des procédures d’exploitation de
données écrites par l’utilisateur, sous la forme de petits programmes (procedures) écrites dans un
langage voisin du C et qui sont compilées. Ainsi, un ensemble de “macros” permet par exemple
d’interfacer un oscilloscope numérique par l’intermédiaire du bus Ieee–Gpib U et de transférer
directement dans le logiciel Igor les données qui correspondent aux oscillogrammes affichés sur
les deux voies de l’appareil. D’autres macros permettent d’utiliser une carte National Instru-
ments de conversion analogique–numérique pour faire l’acquisition et la génération de signaux.

Ces notes ont pour but de montrer comment Igor peut être utilisé comme une bôıte à
outils pour la représentation et l’analyse de données d’expériences. Elles ne cherchent pas à se
substituer aux cours sur l’analyse des données expérimentales qui seront faits par Emmanuelle
Deleporte et André Galais. Par ailleurs, le logiciel est accompagné d’une documentation
détaillée [1], qu’il ne faut évidemment pas hésiter à consulter.

2 Notions de base sur la structure d’Igor

2.1 Quels sont les objets de base de ce logiciel ?

Les principaux objets qui constituent le logiciel Igor sont4 :

1. une wave, objet qui peut parâıtre initialement peu intuitif mais qui fait toute la différence,
et la puissance, de ce logiciel par rapport aux tableurs traditionnels ;

2. un graph, qui correspond à la représentation graphique d’une ou plusieurs “wave” ;

3. une table, qui met simplement sous la forme d’un tableau les données contenues dans des
“waves” ;

4. un page layout, qui permet de réaliser une feuille de présentation incorporant du texte, des
tableaux, des schémas, des graphiques...

Un ensemble de ces objets constitue ce qu’Igor appelle un experiment. Cette “expérience”
est stockée dans un fichier (experiment file) qui porte l’extension .pxp, ou également .pxt pour
les fichiers modèle – template. Quand on ouvre le fichier, Igor va alors à nouveau créer tous les
objets qui le constituaient lors de son enregistrement, en faisant défiler l’histoire de l’expérience.

→ Pour se familiariser avec ces différents objets, ouvrir le fichier SonLa.pxp.

1Ce logiciel, qui est commercialisé par la société Wavemetrics (http://www.wavemetrics.com), est disponible
pour les plateformes Macintosh et Windows.

2Cet anglicisme dénote les méthodes numériques de lissage.
3Pour l’ajustement à une loi modèle de points expérimentaux.
4Afin de pouvoir utiler par la suite la documentation très complète, nous avons choisi de conserver la termi-

nologie anglo-saxonne.
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2.2 Le concept clé de Igor : la “wave”

Le terme de “wave” est utilisé pour décrire un objet Igor qui correspond à une matrice de
nombres. Les “waves” peuvent avoir de une à quatre dimensions et peuvent contenir soit des
données numériques soit du texte.

2.2.1 Utilisation sous la forme classique d’un tableur

Comme on le fait habituellement avec un tableur, une wave peut être créée directement en
tapant les valeurs dans un tableau. Elle peut être également créée en chargeant des données à
partir d’un fichier, pour lequel de nombreux formats d’import sont possibles (texte, texte tab-
ulé...). Chaque “wave” va alors porter un nom, ce qui permettra de s’y référer pour effectuer
des opérations mathématiques, afficher les données qu’elle contient sous la forme de tableau ou
bien la représenter graphiquement. On notera qu’il n’est pas nécessaire de faire apparâıtre les
“waves” dans un tableau pour que celles-ci existent effectivement.

Commençons notre découverte du logiciel en rentrant “à la main” une succession de points
de mesure correspondant à la table 1. Nous en ferons ensuite une représentation graphique.
On lance ainsi le logiciel, et on crée un tableau vide. Puis on y rentre chacune des données,
exactement comme on le ferait dans un tableur 5. Après avoir tapé la première valeur 309
dans la première case (Point 0) de la première colonne vide 6, une wave nommée wave0 est
automatiquement créée. Après avoir rentré tous les points, on aboutit à une fenêtre qui doit
correspondre à celle représentée sur la figure 1.

Résistance(Ω) 84.5 74.5 65 51.4 38.6 30.2 21.9 14 5.1 4.2 3.4 2.7 2.1
Température(K) 309 312 315 320 328 334 342 355 375 400 404 412 421

Table 1: Un tableau de points de mesure, qui correspond aux valeurs mesurées de la résistance R d’une ther-

mistance en fonction de la température T .

Figure 1: Exemple de tableau de mesures rentré point par point dans le logiciel Igor.

5Comme nous l’avons déjà indiqué, il est également possible d’importer au moyen d’un simple copier-coller les
données à partir d’un tableau déjà existant dans un autre logiciel. Dans chacun des cas, on aboutira à la création
de “waves” dont les données sont représentées sur le tableau.

6Chaque point est rentré après avoir tapé return ou enter.
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Nous allons ensuite renommer chacune de ces deux waves, de manière à leur donner un nom
plus approprié. Ouvrons pour cela le menu [Data]> [Rename...]. En suivant les instructions,
appelons wave0 > temperature puis wave1 > resistance. On aurait bien entendu pu choisir
tout autre nom, en prenant toutefois garde aux caractères utilisés 7. La règle est en fait la
même que celle correspondant à la déclaration d’une variable dans un langage de programma-
tion. Les noms choisis peuvent être une simple lettre comme a ou x, ou bien une combinaison
de lettres et de chiffres à condition de commencer par une lettre. Le caractère “blanc souligné”
ou underscore est autorisé : frequence−hz et longueur−cm. Il ne faut pas utiliser de lettres
accentuées, cédilles, trémas, espace, etc. Enfin, contrairement au système d’exploitation Unix,
le logiciel Igor ne fait pas la distinction entre les lettres majuscules et les lettres miniscules :
Temperature est ainsi identique à temperature. Une fois les noms choisis et après avoir cliqué
sur le bouton Do It, on voit s’exécuter une à une les commandes correspondantes.

Il est également possible d’importer des données, en téléchargeant par exemple un fichier au
format texte avec le menu Data > Load Wave > Load General Text. Pour cela, on sélectionnera
le fichier signal.dat à télécharger. Une fenêtre apparâıt alors pour rentrer le nom que l’on
souhaite donner à la wave, par exemple signal. On peut ensuite visualiser le contenu des waves
angle et signal en les rajoutant dans le tableau, à l’aide du menu Table > Append Columns
to Table. On notera enfin qu’il est possible de faire diverses opérations sur les waves comme
les renommer, les exporter dans un fichier texte, supprimer ou rajouter des points, etc. Pour
cela, se laisser guider par le menu Data.

2.2.2 Représentation graphique des données

Les graphiques sont utilisés pour représenter les données contenues dans les waves, chaque trace
dans le graphique correspondant à une “wave”. Lorsque celle-ci est modifiée, le graphique qui
lui est associé est automatiquement modifié.

• Représenter les valeurs de la résistance R en fonction de la température T avec le menu
Windows > New Graph. Mettre des curseurs à la place de la ligne continue (en double-
cliquant sur la courbe), mettre les légendes et une grille (en double-cliquant sur les ordon-
nées/abscisses). On peut compléter le graphique par des indications, à partir du menu
Graph > Add Annotation.

• Placer un curseur sur un point du graph pour visualiser directement ses coordonnées.
Pour cela, utiliser le menu Graph > Show Info ou utiliser le raccourci clavier (Ctrl+I) sur
Windows ou (pomme–i) sur mac.

• Représenter à nouveau la resistance en fonction de la temperature, avec cette fois une
échelle logarithmique en ordonnées (en double-cliquant sur l’axe des ordonnées).

• Créer un diagramme polaire représentant le signal en fonction de l’angle avec le menu
Windows > New > Packages > Polar Graph. Ce type de représentation est utile pour
visualiser le diagramme de rayonnement d’une source ou d’un détecteur, et par exemple
montrer la directivité d’un émetteur à ultrasons ou d’un microphone.

2.2.3 Les waves : une structure différente d’un simple tableur

Les waves dans le logiciel Igor possèdent cependant une spécificité très importante qui mérite
dès à présent d’être expliquée. L’expérimentateur doit très souvent exploiter des mesures qu’il a
prises avec un oscilloscope numérique, un appareil scientifique, ou une carte d’instrumentation
numérique. Il obtient alors quelques centaines ou milliers de points de mesure, régulièrement

7Si par hasard le nom proposé venait à cöıncider avec un nom déjà utilisé par le logiciel (par exemple “time”),
Igor ne manquerait pas de faire savoir son mécontentement.
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espacés dans le temps (waveform data). Les “waves” créées par Igor s’inspirent directement de
cette caractéristique, en associant aux valeurs numériques une échelle (X Scaling) qui permet
de définir l’espacement (en fonction du temps ou d’une autre grandeur) entre deux données
consécutives. Dans ce cas, Igor garde en mémoire la composante y de chaque point de la
“wave”. Par contre, il calcule la valeur de la composante x associée à ce point en fonction
de l’échelle qui a été attribuée à la “wave” (figure 2). On notera que certaines opérations
de traitement de données, comme la transformée de Fourier, l’intégration et la différentiation,
peuvent être uniquement effectuées avec des données sous la forme de “waveform data”.

Figure 2: Structure d’une “wave” en fonction de l’échelle qui lui est associée. L’intervalle entre deux points

de mesure successifs, lequel correspond à l’échantillonnage effectué par l’appareil de mesure, est ici de 40 µs. Le

graphique trace la valeur y du point de mesure en fonction de l’abscisse x qui a été calculée à partir de l’opération

X Scaling.

Il est important de retenir que chaque wave est associée une échelle (X scaling), laquelle
permet de définir l’espacement entre deux données consécutives. Ainsi, à chaque point y de
la wave est associé une abscisse x. Par défaut, l’abscisse x est égale au numéro du point y.
Cependant, on peut modifier cette échelle par défaut au moyen du menu Data > Change Wave
Scaling. On peut alors représenter la wave y en fonction de x, sans créer de wave supplémentaire
pour l’abscisse, à condition bien sûr que les points soient régulièment espacés.

– Télecharger le fichier spectre.dat qui donne le spectre de transmission d’un filtre optique
interférentiel entre λ = 350 nm et λ = 1080 nm.

– Définir l’échelle associée à la wave spectre avec le menu Data > Change Wave Scaling et
représenter ce spectre en fonction de la longueur d’onde (en ordonnée spectre, en abscisse
calculated) entre les longueurs d’onde 350 et 750 nm.

2.3 Les relations entre les différents objets d’Igor

Les liens entre les différents objets (“wave”, “graph”, “table” et “page layout”) sont représentés
très schématiquement sur la figure 3.

Les graphiques sont utilisés pour représenter les données contenues dans les “waves” et il est
possible de les inclure dans un rapport ou une présentation. Pour des logiciels tels que Word ou
Powerpoint, il suffit de faire un “copier-coller” à partir du logiciel Igor. On peut également
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Figure 3: Représentation schématique des liens entre les différents objets de base du logiciel.

enregistrer les graphiques sous des formats particuliers tel que le postcript .eps, format utile
pour les rapports écrits en TEX, avec le menu File > Save Graphics.

Les tableaux sont utilisés pour rentrer des données ou simplement pour les afficher à l’écran
et ensuite les imprimer. On notera cependant une différence importante par rapport à un tableur
classique : si chaque colonne du tableau correspond à des données effectivement contenues dans
une “wave”, celle-ci continue à exister même si l’on vient à la supprimer du tableau ou même à
fermer celui-ci.

Les “page layouts” permettent de visualiser simultanément différentes courbes, d’y super-
poser des tableaux et d’y apporter des annotations ou des figures, des images, etc. Ils sont
créés avec le menu Windows > New Layout et il suffit de sélectionner les graphiques (ou tables)
qui nous intéressent. Si on modifie une table ou un graphe, la représentation de celui-ci est
automatiquement modifiée dans les “layouts” où il figure. Les fenêtres associées aux fonctions
Graph et Layout contiennent des outils rudimentaires pour le dessin vectoriel qui permettent
d’ajouter des flèches, des lignes, des carrés ou rectangles, des polygones, des images, etc.

2.4 D’autres objets pour une utilisation plus élaborée

En complément de ces objets de base, le logiciel permet de créer ou d’utiliser d’autres éléments
plus élaborés :

• Des variables, pouvant correspondre soit à des nombres (numeric variable) soit à des
châınes de caractères (string variable). Ces éléments sont utiles pour stocker des informa-
tions ou effectuer des opérations dans les “procedures”, de manière analogue à ce qu’on
ferait dans un programme écrit dans un langage informatique comme le C ou le Fortran.

• Des dossiers appelés data folders, qui peuvent contenir des “waves”, des variables ou encore
d’autres dossiers de données. De telles structures permettent de pouvoir accéder de manière
directe aux éléments d’une expérience, sans qu’il soit pour autant nécessaire de dérouler
celle-ci 8.

8On notera que comme dans le travail effectué au laboratoire, le logiciel ne travaille que sur une seule expérience
à la fois. Il est ainsi impossible d’ouvrir simultanément deux fichiers, par exemple SonLa.pxp et SonDo.pxp.
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• Des notebooks, qui ont une structure identique aux fichiers des traitements de texte. On
peut utiliser ces “notebooks” pour garder la trace de résultats ou écrire un petit rapport.
Les notes techniques ou la documentation associées à des extensions du logiciel sont en
général disponibles sous cette forme.

• Des panneaux de contrôle (control panels), qui sont des fenêtres contenant des boutons de
commande, des bôıtes de contrôle permettant d’insérer la valeur d’une variable, des menus
déroulants, etc. Ces éléments, dont la réalisation ne demande qu’un apprentissage très
rapide, permettent en particulier de faire un interfaçage commode avec une “procedure”
écrite par l’utilisateur pour obtenir la fonctionnalité désirée.

• Des courbes (surface plots), qui permettent de représenter des données à trois dimensions,
comme par exemple le potentiel en chaque point d’une surface chargée. Différents modes
de représentation (point-cloud, wire frame, filled surface, scatter plot) peuvent être utilisés.
Le logiciel permet également de travailler sur une image, et d’en faire un traitement.

On notera enfin qu’il est possible, au moyen d’instructions très simples, de réaliser des
animations video au format QuickTime montrant l’évolution d’une courbe en fonction d’un
paramètre, ou encore la visualisation d’une succession d’images de manière à créer le film d’un
phénomène. L’exploitation des fonctionnalités de ce logiciel est donc uniquement limitée par
l’imagination, ainsi que le temps disponible malheureusement...

2.5 L’interface utilisateur d’Igor

Le logiciel Igor utilise la combinaison d’une interface graphique, similaire à celle de nombreux
logiciels, et d’une ligne de commande permettant d’exécuter l’une après l’autre des instruc-
tions. Par ce biais, le mode de fonctionnement est tout-à-fait similaire à celui de logiciels de
calcul scientifique comme Matlab, Maple ou Mathematica. C’est cette structure qui permet
d’ajouter des fonctionnalités par l’intermédiaire de programmes.

L’interface utilisateur permet d’appliquer les opérations et fonctions d’Igor aux “waves” qui
ont été créées par l’utilisateur. On peut procéder de trois manières différentes :

1. Taper directement la commande Igor qu’on souhaite exécuter dans la ligne de commande,
située en bas de l’écran (figure 4). Une fois tapée, la commande est exécutée après un
retour chariot et sa mémoire est ensuite conservée dans l’histoire de l’expérience. Afin de
maintenir la traçabilité des opérations qui ont été effectuées, il est fortement recommandé
de ne jamais modifier les informations qui apparaissent dans l’aire de l’histoire. Igor
indique également dans cette fenêtre (history area) les résultats d’analyses effectuées sur
les waves (calcul de données statistiques comme la moyenne et l’écart-type, ou résultats
des procédures d’ajustement de courbes).

2. Utiliser les menus déroulants et se servir des fenêtres de dialogue qui vont alors s’ouvrir
(figure 5). C’est le moyen peut-être le plus simple, mais pas toujours le plus rapide, pour
accéder aux diverses fonctionnalités d’Igor. Lorsqu’on utilise la fenêtre de dialogue, le
logiciel va alors automatiquement fabriquer la commande appropriée qui apparâıt dans la
bôıte de commande 9. Au fur et à mesure que l’on devient familier avec l’utilisation du
logiciel, on s’aperçoit que certaines opérations sont plus facilement réalisées à partir des
menus et des bôıtes de dialogue, tandis que pour d’autres, il est plus efficace d’utiliser
directement la ligne de commande.

3. Écrire une procédure Igor et la compiler pour ensuite pouvoir l’utiliser. C’est une méthode
efficace, qui demande cependant un peu de mâıtrise dans l’utilisation du logiciel.

9Certains menus et dialogues s’effectuent directement en court-circuitant la ligne de commande, car ils corre-
spondent à des fonctionnalités qui n’ont pas d’équivalents dans la ligne de commande.
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presse-papier. Utile pour 
écrire des procédures Igor

9

Figure 4: Interface utilisateur : utilisation de la ligne de commande. On notera qu’il est possible de transférer

une commande à partir de l’historique vers la ligne de commande en tapant simplement return.

Figure 5: Interface utilisateur : utilisation des menus déroulants et des fenêtres de dialogue.

3 Apprenons à représenter une fonction avec Igor

3.1 L’exemple de la distribution de Gauss

3.1.1 Intérêt de cette distibution

Nous allons nous intéresser à une fonction d’une grande importance en physique : la distri-
bution normale, également connue sous le nom de “gaussienne” 10. D’après le théorème de la
limite centrale, cette distribution correspond à la distribution limite associée à la mesure d’une
grandeur x sujette à de petites incertitudes aléatoires. En guise d’introduction, nous ne résistons
pas au plaisir de “raconter” une petite fable 11.

Lorsque l’Allemagne eut perdu la guerre en 1945, la situation économique continua à se

10La découverte de l’importance de cette loi est attribuée aux pionniers du développement de la théorie des
probabilités : d’abord De Moivre (1667–1754), mathématicien d’origine française protestant qui émigra en
Angleterre en 1685 après la révocation de l’Edit de Nantes et l’expulsion des Huguenots, puis le Marquis Pierre
Simon de Laplace (1749–1827) et enfin évidemment, le “petit prince des mathématiques” Karl Fiedrich Gauss
(1777–1855).

11Cette histoire est tirée du merveilleux livre de G. Gamow et M. Stern, “Jeux Mathématiques”, Dunod (Paris,
1966), dédié à “Théodore Von Karman, qui aime bien les petits problèmes”. Il est indiqué dans le livre que cette
fable est rapportée comme véridique et se serait passée à Hambourg après la guerre.
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détériorer rapidement dans le pays. Toute la nourriture resta rationnée, même le pain ; cette
denrée était limitée à 200 grammes par personnes et par jour. Les boulangers étaient par con-
séquent obligés de se procurer des moules spéciaux pour fabriquer des pains pesant exactement
200 grammes et ils en vendaient un par jour à chaque consommateur.

Chaque matin, en se rendant à l’université, un vieux professeur de physique, Herr Pr. Dr.
Herbert W., passait chez le boulanger pour prendre sa ration quotidienne. Un jour il lui dit :

— Vous êtes un profiteur, vous volez vos clients. Les moules dont vous vous servez sont de 5
pour cent plus petits qu’ils ne devraient l’être pour faire des pains de 200 grammes, et la farine
que vous économisez, vous la vendez au marché noir.

— Mais, Monsieur le Professeur, s’écriat le boulanger, personne ne peut donner à tous ses
pains exactement le même poids. Certains sont quelques pour cents plus légers, d’autres quelques
pour cent plus lourds.

— C’est bien cela, répliqua le professeur, depuis quelques mois, je pèse chaque jour le pain
que vous me vendez sur la balance de précision de mon laboratoire. Son poids varie suivant
la loi normale. Mais voici la courbe qui donne la répartition des pains de divers poids (figure
6a), comparée au poids de la ration. Vous voyez que certains pains ne pèsent que 185 grammes
et que d’autres pèsent 205 grammes mais que le poids moyen obtenu dans ces mesures est de
195 grammes au lieu de 200. Vous allez vous procurer des moules de taille correcte, ou je vous
dénonce au service du ravitaillement.

— Je le ferai dès demain, Monsieur le Professeur, dit le boulanger atteré, et soyez bien assuré
que cette faute ne se renouvellera pas.

Figure 6: Distribution du poids des pains achetés chez le boulanger par le Pr. Dr. Herbert W.

Quelques mois plus tard, le professeur revint trouver le boulanger.
— Je viens de vous dénoncer au service du ravitaillement, dit-il. Vous n’avez pas changé vos

moules et vous continuez à voler vos clients.
— Mais, Monsieur le Professeur, s’exclama le boulanger, vous ne pouvez pas m’accuser de

vol ! Vous ai-je jamais donné des pains trop légers ces derniers mois ?
— En effet, ils pesaient tous au moins 200 grammes. Mais ce n’est pas parce que vous avez

utilisé des moules plus grands ; vous avez tout simplement choisi pour moi les plus gros pains,
et gardé les plus petits pour les autres clients.

— Vous ne pouvez pas le prouver, dit le boulanger avec arrogance.
— Justement si, déclara le professeur. Regardez la distribution statistique que j’ai obtenue

en pesant vos pains au cours de ces derniers mois (figure 6b). Au lieu de la distribution normale
démontrée par le grand mathématicien Karl Friedrich Gauss, vous avez une courbe qui corre-
spond à des pains trop lourds ; elle s’arrête brusquement à gauche, et descend progressivement
à droite. Jamais des écarts statistiques autour de la moyenne ne pourraient conduire à une telle
distribution, et il est clair que vous avez obtenu cette courbe artificiellement en choisissant des
pains qui pesaient plus que le poids minimum autorisé. Cette courbe est tout simplement le
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pied de la courbe de Gauss (figure 6a) : elle représente la même distribution que celle que j’avais
obtenue en pesant mes pains avant notre précédente conversation. Je suis certain que le service
du rationnement me croira sur parole.

Et, tournant les talons, le Pr. Dr. Herbert W. sortit de la boutique.

On notera qu’en réalité, aucune mesure n’est jamais distribuée exactement suivant la loi
gaussienne. Si on répète un grand nombre de fois la mesure d’un paramètre et qu’on trace
l’histogramme de ces mesures en fonction de la valeur trouvée, la forme de l’histogramme tend
vers une répartition de Gauss lorsqu’on fait tendre le nombre de mesures vers l’infini. Pourquoi
cela ? On dit parfois que les expérimentateurs pensent qu’elle a été prouvée par les mathémati-
ciens, puisque sa forme peut être justifiée lorsque les conditions de Borel sont vérifiées, c’est-
à-dire lorsqu’il existe des causes d’erreurs multiples d’importance comparable (cf. l’expérience
du quinconce de Galton décrite dans l’Annexe B). À l’inverse, les mathématiciens pensent
qu’elle est un résultat de l’expérience, puisqu’elle est obtenue dans la quasi-totalité des cas où
un expérimentateur soigneux a pris le temps de regrouper un très grand nombre de mesures
indépendantes et de poids égaux d’une même grandeur.

Si la distribution normale est effectivement obtenue pour un très grand nombre d’expériences,
certaines mesures effectuées dans des régimes de comptage 12 n’obéissent cependant plus à
ce type de statistique lorsque le nombre de “coups” est très faible. Il faut alors utiliser des
procédures d’analyse de données adaptées à la situation considérée. On notera également qu’il
existe d’autres distributions de probabilité, appelées “vols de Lévy”, qui s’écartent de manière
fondamentale de cette limite centrale puisqu’elles ne possèdent ni valeur moyenne ni variance [2].
Alors que celles-ci ont longtemps été considérées comme de simples curiosités mathématiques,
on a découvert récemment qu’elles jouent un rôle crucial dans des domaines aussi variés que la
biologie, les marchés financiers, ou encore les embouteillages de la circulation automobile ! Elles
se rencontrent également dans différents phénomènes de physique dont l’évolution temporelle
est dominée par l’occurence d’événéments rares, comme par exemple la diffusion de particules
dans les milieux fortement hétérogènes ou le refroidissement d’atomes par laser.

3.1.2 Expression mathématique de la loi normale

L’expression mathématique de la loi normale, fonction de deux paramètres µ et σ (avec σ > 0),
est :

G(x) =
1

σ
√

2π
e−(x−µ)2/(2σ2) . (1)

Nous savons évidemment que G(x) a une forme de courbe “en cloche”, symétrique par rapport
à µ qui correspond à la valeur de x pour laquelle la courbe atteint son maximum. Le paramètre
σ caractérise la largeur de la courbe, tandis que le facteur σ

√
2π assure la normalisation de la

distribution de probabilité dP = G(x)dx associée à cette fonction, c’est-à-dire :∫
dP =

∫ +∞

−∞
G(x)dx = 1 . (2)

Les paramètres µ et σ peuvent être interprétés comme les premiers moments de la distribution
de probabilité 13 donnée par la loi normale G(x) :

• µ correspond à la valeur moyenne 〈x〉 de la variable x :

µ = 〈x〉 =
∫ +∞

−∞
xG(x)dx . (3)

12Par exemple, la détection de désintégrations radioactives en physique nucléaire ou bien des mesures optiques
par comptage de photons pour de très faibles flux lumineux.

13On appelle moment d’ordre n d’une distribution de probabilité P(x) la valeur moyenne de xn, calculée selon

〈xn〉 =
∫ +∞
−∞ xnP(x)dx. Quelques rudiments de statistique sont rappelés dans l’Annexe A.
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Cette quantité porte également le nom d’espérance mathématique 14, notée E(x).

• σ correspond à l’écart-type ou écart quadratique moyen ∆x de la variable x, défini comme

(∆x)2 = σ2 = 〈(x − 〈x〉)2〉 soit σ2 = 〈x2〉 − 〈x〉2 . (4)

Le paramètre σ2 est encore appelé variance V(x) de la loi de probabilité. Plus σ est
petit, plus il est probable que l’on trouve une valeur de x proche de la moyenne. La
quantité σ constitue par conséquent une mesure de l’écart à la moyenne, et elle quantifie
les fluctuations de la variable aléatoire x autour de la valeur moyenne µ.

3.1.3 Le tracé de la gaussienne à l’aide d’Igor

Amusons-nous à tracer deux de ces fonctions gaussiennes pour µ = 10 et deux valeurs du
paramètre σ (σ = 2 et σ = 4). Il faut déjà créer les “waves” correspondantes. Nous pouvons
pour cela utiliser le menu déroulant [Data]→ [Make Waves...], puis suivre les indications. En
suivant les instructions, convenons d’appeler “gauss1” la première wave .

Figure 7: Création d’une wave à l’aide des menus déroulants.

Une fois le nom choisi, ainsi que le nombre de points (ici 10 000, comme indiqué sur la figure
7) et après avoir cliqué sur le bouton Do It, on voit s’exécuter la commande correspondante

Make/N=10000/D gauss1
qui vient immédiatement s’inscrire dans l’histoire de l’expérience. Donnons ensuite les valeurs
à la wave pour µ = 10 et σ = 4, en utilisant directement la ligne de commande :

gauss1= 1/(4*sqrt(2*pi))*exp(-(x-10)∧2/(2*4∧2))
Nous pouvons ensuite essayer de tracer la courbe à l’aide du menu [Windows]→ [New Graph...],
et en choisissant gauss1 en fonction de −calculated−. La courbe qui apparâıt à l’écran n’est
pas du tout celle que nous pouvions attendre (figure 8–a) ! En effet, nous avons (volontairement)
oublié de spécifier l’échelle selon l’axe des x qui doit être attribuée à cette “wave”. Le logiciel
a alors pris comme abscisse par défaut le numéro du point correspondant et c’est pour cela
que l’abscisse du graphique va de 0 à 10 000... Pour spécifier l’échelle suivant x (par exemple
entre 0 et 20), nous pouvons utiliser le menu [Data]→ [Change Wave Scaling...], ou bien taper

14Cette appellation tire son origine de l’analyse faite au XVIIème siècle du “problème des partis”, en lien avec
l’application des probabilités aux jeux de hasard : quelle est la juste répartition des enjeux lorsqu’une partie d’un
jeu de pur hasard est interrompue avant son terme. Des savants aussi illustres que Pascal, Fermat et Huygens
se sont intéressés à ce problème et ont montré que la répartition doit se faire selon les probabilités de gagner des
joueurs, calculées à partir de toutes les suites possibles de la partie. Chaque joueur recevra alors son “espérance
de gain” au moment de l’interruption du jeu.
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directement l’instruction correspondante dans la ligne de commande :
setscale x,0,20,gauss1

Pour trouver le résultat attendu, nous devons encore recalculer la valeur de gauss1 en fonction
de la valeur de x qui est maintenant spécifiée pour chaque point de la “wave” :

gauss1= 1/(4*sqrt(2*pi))*exp(-(x-10)∧2/(2*4∧2))
et nous voyons alors que la courbe qui représentait gauss1 s’est ajustée en temps réel pour
aboutir à celle qui est représentée sur la figure 8 (b).

Figure 8: Tracé d’une fonction gaussienne : (a) sans avoir spécifié l’échelle suivant x de la “wave” correspondante

puis (b) avec l’échelle suivant X correctement spécifiée. On remarquera la très rapide décroissance de la gaussienne

de part et d’autre de son maximum. Cette caractéristique la distingue de la lorentzienne.

Nous souhaitons maintenant afficher sur le même graphe une deuxième courbe, laquelle va
correspondre à une distribution gaussienne avec µ = 10 et σ = 2. Plutôt que d’écrire à nouveau
la fonction, on peut trouver plus judicieux de définir une fonction générique en fonction des deux
paramètres µ et σ. C’est ce que nous allons maintenant faire en tapant un petit programme
dans la fenêtre Procedure, et en complétant les instructions par des commentaires (figure 9) :

Function Gaussienne(x, param1, param2)
Variable x,param1, param2 // Declaration des parametres
Variable CalculGauss // Declaration de la variable locale
CalculGauss = 1/(param2*sqrt(2*pi))*exp(-(x-param1) ∧2/(2*param2∧2))
return CalculGauss

End

Figure 9: Définition d’une fonction “gaussienne” donnée par l’Éq.(1) en fonction des deux paramètres param1

et param2, lesquels correspondent respectivement aux valeurs de la valeur moyenne µ et de l’écart-type σ.

Il faut ensuite effectuer la compilation de ce programme rudimentaire en cliquant sur le
bouton Compile en bas de le fenêtre. Une fois cette compilation effectuée correctement, nous
pouvons alors tester le programme en tapant dans la ligne de commande :

print Gaussienne(10,10,2)
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L’ordinateur va alors retourner 0.199471, valeur qui correspond à l’évaluation de la fonction
gaussienne donnée par l’Éq.(1) pour x = 10 et avec comme paramètres µ = 10 et σ = 2. Nous
avons maintenant tous les éléments pour créer une deuxième “wave”, en choisissant par exemple
de taper les instructions correspondantes directement dans la ligne de commande :

Make /N=10000 gauss2; Setscale x,0,20,gauss2 ; gauss2=Gaussienne(x,10,2)
AppendToGraph gauss2

On notera que la séparation entre deux instructions sur une même ligne est obtenue par l’insertion
d’un point-virgule. On voit alors se superposer sur le tracé de la wave gauss1 celui correspon-
dant à gauss2 (figure 10).

Au moyen des curseurs disponibles, il est possible de déterminer la position du maximum
d’une courbe, ou bien encore d’évaluer la largeur totale à mi-hauteur 15 d’une courbe en cloche.
On s’amusera ainsi à vérifier que la valeur pour la loi gaussienne qu’on peut ainsi déterminer “à
l’œil” est bien en accord avec celle calculée :

∆x1/2 = 2
√

ln 2σ (FWHM) soit ∆x1/2 � 2.355 × σ .

Figure 10: Tracé des deux courbes représentatives d’une loi de Gauss pour X = 10 et σ = 4 ou σ = 2. Les deux

curseurs placés sur le tracé de gauss2 permettent de déterminer grossièrement la largeur à mi-hauteur ∆x � 4.7

de cette courbe correspondant à σ = 2. De manière plus rigoureuse, on sait que la hauteur de la gaussienne en

x = X ± σ est égale à 1/
√

e la valeur pic. Puisque 1/
√

e � 0.607, le paramètre σ peut être approximativement

considéré comme égal à la demi-largeur à mi-hauteur de la gaussienne.

3.2 La fonction “erreur” : calcul et tracé

En faisant les changements de variable

u =
x − µ

σ
et du =

dx

σ

la fonction gaussienne peut être mise sous une forme normalisée, avec une valeur moyenne nulle
et un écart-type égal à l’unité :

y =
1√
2π

e−u2/2 . (5)

Cette expression donne en particulier la probabilité Pt×σ qu’une mesure de la grandeur x soit
comprise entre µ − t × σ et µ + t × σ :

Pt×σ =
1√
2π

∫ +t

−t
e−u2/2du =

√
2
π

∫ t

0
e−u2/2du (6)

Cette intégrale est connue sous le nom de “fonction erreur” Φ(t), appelée encore intégrale de
l’erreur normale. Si cette fonction ne peut être calculée analytiquement, on trouvera dans tous

15Appelée encore FWHM pour Full Width at Half Maximum.
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les livres de statistiques des tables qui fournissent pour de nombreuses valeurs de t la valeur
correspondante de Φ(t). Nous allons pour notre part nous amuser à la calculer, en utilisant pour
cela la fonction Integrate qui remplace une wave par son intégration obtenue à l’aide de la
méthode des rectangles 16.

Commençons par créer une wave correspondant à la fonction gaussienne normalisée donnée
par l’Éq.(5) :

Make /N=10000 GaussNorm; Setscale x, 0,5,GaussNorm
GaussNorm= Gaussienne(x,0,1)

Si on effectue directement l’instruction Integrate GaussNorm, chaque point p de la “wave”
GaussNorm sera alors directement remplacé par une valeur numérique calculée selon la formule :

i=p∑
i=0

wave[i] × ∆x

de sorte que le contenu initial de la “wave” GaussNorm sera alors perdu. Nous allons donc
commencer par recopier le contenu de cette wave dans une nouvelle “wave”, laquelle sera au-
tomatiquement définie selon la même échelle entre x = −5 et x = +5, puis nous effectuerons
l’intégration

Duplicate GaussNorm IntGauss; Integrate IntGauss
Nous obtenons finalement l’expression approchée de la fonction “erreur” par les instructions :

Make /N=10000 FunctionErf; Setscale x, 0,5,FunctionErf
FunctionErf= IntGauss(x) ; Display FunctionErf

Le résultat de ces différentes opérations est représenté sur la figure 11. Nous voyons ainsi
que la probabilité que le résultat X d’un tirage de la grandeur x tombe à moins d’un écart-type
δx = σ de la valeur moyenne µ est de 0.68. Quand on augmente l’intervalle, cette probabilité va
tendre rapidement vers 100 %. Ainsi, la probabilité qu’une mesure soit à ±2σ (resp. ±3σ) est
de 95.4 % (resp. 99.7 %). De manière générale et plus qualitative, nous dirons que la “largeur”
de la distribution gaussienne des erreurs est de l’ordre de l’écart-type σ.

Figure 11: Tracé de la fonction “erreur” Φ(t) à partir de l’intégration numérique d’une fonction gaussienne

normalisée. Le résultat correspond à la probabilité Pt×σ que le résultat d’un tirage de la variable aléatoire x se

trouve dans un intervalle de t fois son écart-type σ autour de la valeur moyenne µ. On notera que des formes

légérément différentes de cette fonction sont pré-définies dans le logiciel, sous la forme Erf(x) qui correspond à

la fonction de répartition de la loi normale définie par F (x) =
∫ x

−∞ G(x′)dx′, et erfc(x) qui correspond à 1 -

erf(x).

16Une option Integrate /T permet d’effectuer l’intégration numérique à l’aide de la méthode des trapèzes. On
trouvera une description de ces différentes méthodes d’intégration numérique dans la Réf.[7].
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3.3 Interprétation statistique d’une opération de mesurage

3.3.1 Moyenne et incertitude d’une mesure

Le calcul que nous venons d’effectuer va nous permettre de mieux comprendre l’écriture du
résultat de mesures d’une grandeur donnée x, sous la forme :

x = xm ± ∆x (7)

où xm est la meilleure estimation de la grandeur mesurée x et ∆x l’incertitude sur la mesure. Ne
craignons pas d’insister sur l’importance de l’estimation de l’incertitude ∆x. En son absence,
il n’est plus possible ni pertinent de comparer entre eux des résultats. Comment savoir, sans
connâıtre l’incertitude, si une grandeur a évolué, si tel procédé de mesure conduit au même
résultat que tel autre, si la différence éventuellement observée entre les résultats obtenus par
des méthodes ou des équipes différentes est significative ou bien si elle est uniquement due à
des phénomènes aléatoires mal mâıtrisés ? Comment comparer le résultat qu’on a obtenu à la
valeur qui a été publiée dans un article scientifique ? Comment le comparer à des valeurs de
référence spécifiées par exemple dans une norme ou dans les objectifs d’un contrat, et garantir
ainsi la conformité du produit ou du système réalisé ?

Dans son rapport sur le concours 1998, le jury de l’épreuve de montage à l’agrégation de
physique avait insisté sur le fait que trop de candidats ne savent pas comment aborder le problème
de la précision des résultats et l’évaluation d’une incertitude de mesure, représentée par le
terme ∆x dans l’Éq.(7). La critique des résultats obtenus repose trop souvent sur un calcul
d’incertitude uniquement basé sur l’utilisation de différentielles dont on a pris la valeur absolue.
Malheureusement, cette méthode, qui a été longtemps enseignée et utilisée par les physiciens,
n’est pas appropriée car le résultat qu’elle fournit est à la fois optimiste et pessimiste :

– Il est pessimiste car il suppose que toutes les causes d’erreur agissent dans le même sens. Il
s’agit là d’un cas particulièrement défavorable qui n’a que peu de chances de se produire.

– Il est optimiste car il suggère que la valeur cherchée ne peut pas être à l’extérieur de la
barre d’incertitude [xm−∆x, xm+∆x] et que celle-ci représente par conséquent un domaine
de valeurs qui contient à “coup sûr” la valeur cherchée x.

La définition de l’incertitude sur la mesure est en réalité liée à des considérations d’ordre
statistique 17 : l’intervalle ∆x doit être présenté comme un domaine à l’intérieur duquel la
vraie valeur xexact a de “fortes chances” d’être contenue. La dispersion des résultats de mesure
observée lorsqu’on répète l’opération de mesure dans des conditions apparemment identiques,
justifie l’adoption de cette démarche de description statistique des mesures. Puisque la réali-
sation d’une mesure comporte nécessairement une part d’aléatoire, la grandeur physique x est
alors caractérisée, non plus par une valeur exacte, mais par la probabilité de trouver telle ou
telle valeur. Nous devons ainsi interpréter le résultat d’une mesure de cette grandeur comme le
résultat X d’un tirage au sort d’une variable aléatoire x dans l’ensemble, en général infini,
des résultats possibles. Ce tirage au sort de x est associé à une fonction de distribution de
probabilité F(X, x), et nous ferons l’abus de la noter simplement F(x).

Nous pouvons maintenant interpréter correctement les différents termes dans l’Éq.(7) :

17Il faut ainsi se débarasser de certains a priori sur l’utilisation des outils d’analyse statistique, lesquels sont
malheureusement souvent considérés comme une simple description austère et sans âme des faits économiques ou
démographiques. Les analyses des statisticiens sont également parfois perçues avec un mélange de scepticisme ou
de méfiance, à l’instar de Mark Twain qui déclarait qu’il existe trois formes de mensonges : lies – damned lies
– and statistics. La statistique est en réalité une discipline importante, partie intégrante de tout processus de
recherche élaboré à partir d’un ensemble de données brutes.
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– La moyenne xm correspond à la valeur moyenne 〈x〉, calculée avec la distribution de
probabilité F(x) :

〈x〉 =
∫

xF(x) dx ;

– L’intervalle (ou la barre d’erreur) [xm − ∆x, xm + ∆x] est défini comme un “intervalle
de confiance”, associé à une probabilité donnée P de contenir la valeur vraie xexact de la
grandeur mesurée [3]. Cette probabilité est appelée niveau de confiance et la valeur
choisie en pratique est P = 0.95 = 95 % ou P = 0.99 = 99 % 18.

Ainsi, si l’on fait l’hypothèse que les différentes valeurs pouvant être obtenues pour la mesure
d’une grandeur physique donnée sont distribuées selon une probabilité gaussienne, on peut alors
évaluer à partir du calcul effectué précédemment de la fonction erreur Φ(t) le risque encouru
lorsqu’on donne pour la valeur de la grandeur un intervalle de confiance, appelé encore intervalle
de “certitude mâıtrisée”. En limitant cet intervalle à ±(2 × σ) autour de la valeur estimée, le
risque de trouver une valeur au-delà des bornes de l’intervalle est inférieur à 5 % 19.

3.3.2 Erreurs aléatoires et erreurs systématiques dans un mesurage

Les considérations précédentes montrent qu’il convient de faire, pour chaque mesurage, un in-
ventaire précis et rigoureux des causes d’erreur susceptibles de biaiser le résultat. Il faut ensuite
effectuer les corrections nécessaires, évaluer l’incertitude associée à chacune de celles-ci, puis
composer ces termes avec la dispersion liée à la non répétabilité du procédé de mesure. On
pourra alors exprimer le résultat du mesurage sous la forme d’un intervalle de confiance, dont
la valeur aura été déterminée à partir de l’écart-type σ associé au résultat obtenu.

La composition quadratique des différentes contributions à l’incertitude de mesure, chacune
exprimée sous forme d’écart-type (même si l’appréciation de celui-ci ne résulte pas d’une multi-
plicité de mesures), correspond alors mieux à la prise en compte simultanée des causes d’erreur
indépendantes. Ainsi, lors de la détermination d’une résistance R par voltmètre et ampèremètre,
il n’est a priori pas justifié de corréler les composantes de l’incertitude associées à la mesure de
la tension U et à celle de l’intensité I. Cette corrélation est implicite dans le calcul habituel par
différentielle logarithmique

∆R

R
=

∆U

U
+

∆I

I

qui tend à qualifier un hypothétique “intervalle maximal” pour le résultat. Pour exprimer
l’écart-type σR sur la mesure de la résistance R, il est plus “raisonnable” d’utiliser la relation
de “propagation des erreurs” (

σR

R

)2

=
(

σU

U

)2

+
(

σI

I

)2

.

Si cette expression a un sens mathématique bien défini, on pourra se contenter dans la pratique
de dire que l’incertitude relative ∆R/R est de l’ordre de :

∆R

R
≈

√(
∆U

U

)2

+
(

∆I

I

)2

.

18Il est bon de savoir que l’utilisation de ces méthodes statistiques pour la donnée des incertitudes ne se sont
imposées qu’au début des années 1990, avec l’installation des normes d’assurance qualité Iso 9000 dans le monde
de l’entreprise. Ces méthodes avaient en réalité été mises au point dès le début du XXème siècle et adoptées
par quelques industries, comme par exemple l’agriculture et l’industrie textile, dans le but de rationnaliser et
améliorer la production.

19On notera l’importance du choix du niveau de certitude, corrélé à la définition de l’incertitude de la mesure.
Si nous avions choisi de définir l’incertitude ∆x à ±(1 × σ), un tiers des mesures effectuées tomberait alors
statistiquement en dehors de l’intervalle [xm −σ, xm +σ]. Remarquons qu’en toute rigueur, le niveau de confiance
P = 95% corrspond à ±(1.96 × σ).
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Une première cause de variation des résultats de mesure réside dans les appréciations du
manipulateur lui-même. On ne refait jamais la mesure exactement dans les mêmes conditions,
parce que la lecture des instruments va changer d’une mesure à la suivante : erreur de parallaxe
dans le repérage d’un trait ou de l’indication d’une aiguille, effets de ménisque pour le niveau
de liquide dans une pipette, fatigue au bout de longues heures de travail sur la manip...

Il existe également bien d’autres sources d’erreurs qui peuvent affectuer le résultat brut d’un
mesurage. Voici tout d’abord quelques exemples d’erreurs systématiques :

– La grandeur mesurée elle-même est parfois mal définie. Il faut alors se demander quelles
sont les conditions de validité de la loi modèle prévue, savoir si la grandeur mesurée
varie dans le temps ou dans l’espace. La grandeur peut également avoir une dispersion
intrinsèque. C’est par exemple le cas pour la mesure de l’énergie d’un niveau instable d’un
noyau ou d’un système atomique ou la mesure de la position d’une particule microscopique
lorsque celle-ci est sujette au mouvement brownien créé par son environnement.

– La grandeur étudiée peut être affectée par le procédé de mesure lui-même, ce qui impose
alors l’usage de méthodes d’échantillonnage. Le mode opératoire choisi peut également
introduire des erreurs. Ainsi, une pesée effectuée dans l’air doit prendre en compte une
correction due à la poussée d’Archimède ; une mesure de résistance effectuée à l’aide d’un
voltmètre et d’un ampèremètre est biaisée aussi bien dans les configurations “courte” ou
“longue” dérivation...

– Les capteurs et les instruments utilisés pour la mesure, et avec lesquels le système est mis
en interaction, peuvent présenter des défauts : temps de réponse fini et bande passante
limitée, justesse et sensibilité d’un instrument de mesure 20, réponse non-linéaire d’un
capteur, effets d’hystérésis...

– De nombreuses grandeurs qui caractérisent les conditions d’ambiance dans lesquelles la
mesure est réalisée vont influer sur le résultat. Il s’agit selon les cas de la température, des
conditions électriques ou magnétiques, de la présence ou non de lumière parasite...

De tels effets doivent être recherchés puis quantifiés, de manière à pouvoir éventuellement
introduire des corrections permettant de compenser les erreurs systématiques ainsi introduites.
Les constructeurs fournissent en particulier des indications concernant la précision de leurs
appareils ou de leurs composants, sous la forme d’une incertitude à attribuer aux mesures effec-
tuées. Il faut alors se reporter aux notices du constructeur pour connâıtre le sens précis... de la
“précision” indiquée, sachant que celle-ci est également donnée suivant une norme industrielle.
Ainsi, la norme Iso 9000 précise aux fabricants comment ils doivent procéder en pratique pour
fournir les indications quantitatives sur les caractéristiques des produits qu’ils commercialisent.
Prenons ainsi l’exemple d’une résistance donnée avec une précision de 1 %. Cette indication
recouvre d’abord un aspect d’échantillonnage, puisque l’industriel va fabriquer des milliers – ou
des millions – de produits, dont les résistances vont varier nécessairement un peu d’un exem-
plaire à l’autre. Il va également inclure un aspect de fonctionnement, puisque la résistance va
changer avec la température du composant, qui est elle-même fonction de l’intensité du courant.
En donnant R avec une incertitude de 1 %, le fabricant donne une limite à l’effet global de
ces différents facteurs, la valeur correspondant dans la norme à deux fois l’écart-type σ sur
l’échantillon de mesures.

20On prendra soin de distinguer la sensibilité, qui indique la variation de l’indication de l’appareil en fonction
de la variation de la grandeur à mesurer, et la justesse de l’appareil. S’il est mal calibré, un dispositif de mesure
peut être sensible sans être pour autant juste. C’est par exemple le cas d’une mesure de température effectuée à
l’aide d’une thermistance, par comparaison avec une mesure effectuée au moyen d’une sonde étalon à résistance
de platine.
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Lors des montages, il s’agit également souvent de comparer le résultat de la mesure à ce
qu’on appelle parfois abusivement la valeur “théorique” et qui, la plupart du temps, est issue
de “valeurs nominales”. Si celle-ci figure dans un recueil de données comme dans le cas d’une
constante physique fondamentale ou de la longueur d’onde d’une radiation, elle est en général
bien connue. L’incertitude sur la valeur tabulée dans le recueil peut être négligée et il suffira
de vérifier que cette valeur tombe à l’intérieur de l’intervalle de confiance déterminé pour la
mesure. Dans d’autres cas, la connaissance imparfaite des valeurs de référence utilisées, des
courbes d’étalonnage des instruments induit également des erreurs sur la valeur “théorique”
de comparaison. Il est alors nécessaire de lui attribuer également une incertitude afin de pou-
voir parvenir à une comparaison pertinente entre le résultat de la mesure et la valeur de référence.

Pour donner un exemple d’une telle situation, considérons ainsi la détermination de la
fréquence de résonance d’un circuit RLC série et la vérification de la formule LCω2

0 = 1. La
mesure directe de la fréquence de résonance ω0 doit être effectuée avec soin. Si la technique des
courbes de Lissajous à l’oscilloscope est utilisée, il faut se placer dans les meilleures conditions
pour repérer la situation dans laquelle l’ellipse est réduite à un segment de droite. On doit donc
veiller à faire les traces les plus fines possibles et à travailler avec des calibres qui correspondent
à des valeurs maximales du gain. Si la fréquence ω0 est mesurée à l’aide d’un fréquencemètre de
qualité, la seule incertitude à prendre en compte est pratiquement celle du pointé. L’incertitude
sur le calcul de la pulsation ω0 peut ensuite être estimée à l’aide des formules habituelles. Il
faut savoir qu’une bobine réelle peut être assimilée à une inductance L qui n’est pas absolument
constante lorsque la fréquence à laquelle elle est utilisée varie, si bien qu’il est loin d’être ac-
quis que le calcul donne une meilleure précision que la mesure. Des remarques du même ordre
peuvent également être faites à propos de la période du pendule pesant et de la confrontation
des résultats expérimentaux obtenus aux prévisions que permettent les formules mathématiques
habituelles.

Quitte à nous répéter, disons-le encore une fois : une valeur mesurée n’est pas une
valeur certaine. La dispersion des résultats est la signature de la variabilité de la mesure,
laquelle est un phénomène objectif. De plus, il existe une certaine méconnaissance de la valeur
pour chaque correction individuelle et par conséquent de la correction totale. Une fois prises en
compte toutes les causes d’erreur, on appelle incertitude de mesure le paramètre associé au
résultat qui caractèrise la dispersion des valeurs numériques. Et nous retiendrons pour la suite :

Une mesure s’exprime toujours par la valeur mesurée et son incertitude.

On aura évidemment l’honnêteté de ne jamais évaluer l’erreur sur une quantité mesurée en
comparant la valeur trouvée expérimentalement à un quelconque chiffre déniché dans un livre
ou sur une page web !
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4 Comment exploiter une série de mesure ?

4.1 Application de la méthode du “maximum de vraisemblance”

4.1.1 Position du problème

La réalisation d’une mesure d’une grandeur physique est schématisée sur la figure 12. La répéti-
tion (à l’identique, autant que faire se peut) du procédé de mesure direct conduit à associer à
la grandeur mesurée (ou mesurande) un ensemble de N valeurs numériques, qui correspondent
aux résultats bruts des mesurages :

{x1, x2, · · · , xN}i=1···N .

L’ensemble de ces valeurs constitue ce nous appellerons l’échantillon de mesures.

Figure 12: Mesure de la grandeur x, associée à une distribution de probabilité inconnue f(x). La figure

montre la relation entre l’échantillonnage, qui correspond à N tirages au sort de la variable aléatoire x, et

l’estimation, procédure d’exploitation de l’échantillon de mesure pour obtenir des informations sur la distribution

de probabilité f(x). Les paramètres de cette distribution sont estimés à partir d’une statistique calculée sur la

base de l’échantillon.

En pratique, on ne fait jamais assez de mesures pour connâıtre la distribution limite asso-
ciée à la mesure de la grandeur x, de sorte que les paramètres µ et σ qui interviennent dans
l’expression de la distribution gaussienne restent inconnus. Le problème va souvent se ramener
à exploiter de manière optimale l’échantillon de mesures pour essayer d’obtenir les valeurs es-
timées des paramètres de la distribution de probabilité f(x) associée à la mesure de x. Cette
estimation, dont nous attendons qu’elle soit d’autant meilleure que le nombre N d’éléments
dans l’échantillon est grand, nous permettra alors de déterminer de manière statistique le ré-
sultat de mesures ultérieures de cette grandeur x. Afin de bien faire resortir la différence entre
paramètres de la distribution de probabilité et grandeurs statistiques, nous utiliserons des sym-
boles différents. Ainsi, les caractéristiques de la distribution de probabilité seront notées par des
lettres grecques tandis que les caractéristiques statistiques de l’échantillon seront notées par des
lettres romaines.

Il existe plusieurs méthodes pour déterminer les “estimateurs” des paramètres inconnus.
Nous pouvons en particulier utiliser une méthode d’estimation du “maximum de vraisemblance”
qui fut introduite par R. A. Fisher (figure 13).



4.1 Application de la méthode du “maximum de vraisemblance” 21

Figure 13: Sir Ronald Aylmer Fisher (1890–1962). Il est reconnu comme un des fondateurs de la statistique

moderne, en étant un des premiers à introduire les méthodes statistiques en agronomie en partant de schémas

d’expériences pour la recherche ou le contrôle des sources de variations.

Pour appliquer cette méthode, nous devons connâıtre les distributions de probabilité nor-
malisées des variables xi qui forment notre ensemble de données,

f(xi; θ)

où θ correspond de manière générique au paramètre à estimer duquel dépend la distribution
de probabilité. Nous pouvons alors considérer le produit de ces fonctions pour l’ensemble des
mesures effectuées :

L(x1, x2, · · · , xN ; θ) = f(x1; θ) f(x2; θ) · · · f(xN ; θ) , (8)

que nous appellerons “fonction de vraisemblance” pour le paramètre θ. Le principe de “vraisem-
blance maximale” nous dit que pour l’ensemble d’observations, la valeur θ∗ qui rend maximal L
correspond au meilleur estimateur du paramètre θ :(

∂L(x1, x2, · · · , xN ; θ)
∂θ

)
θ=θ∗

= 0 . (9)

Pour chercher cet estimateur, il est plus commode, et cependant équivalent du point de
vue mathématique puisque le logarithmique est une fonction toujours croissante, de chercher
le maximum de lnL. Supposons en particulier que notre ensemble de N données {x1 · · ·xN}
soit tiré d’une distribution sous-jacente correspondant à une répartition gaussienne de valeur
moyenne µ et d’écart-type σ :

f(xi; µ, σ) =
1

σ
√

2π
exp

[
−1

2

(
µ − xi

σ

)2
]

. (10)

En supposant que les N mesures sont indépendantes, nous avons alors :

L =
N∏

i=1

f(xi, µ, σ) et W = lnL = −N ln
(
σ
√

2π
)

− 1
2

N∑
i=1

(
µ − xi

σ

)2

. (11)
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4.1.2 Estimateur de la moyenne µ

Pour déterminer l’estimateur de la valeur moyenne µ, nous pouvons ainsi calculer

∂W

∂µ
= −

N∑
i=1

µ − xi

σ2
. (12)

Cette expression est nulle pour :
N∑

i=1

µ∗ − xi

σ2
= 0

soit :

µ∗ = m avec m =
1
N

n∑
i=1

xi (13)

Par conséquent, si un ensemble de mesures obé̈ıt à une distribution de probabilité gaussienne,
la “valeur la plus vraisemblable” de la grandeur mesurée x vis-à-vis des valeurs mesurées {xi}
est simplement la moyenne arithmétique m. Nous appellerons cette grandeur la moyenne
d’échantillon ou la moyenne expérimentale.

Pris dans le sens inverse, c’est en fait en partant de ce résultat que Karl Friedrich Gauss,
qui dirigeait l’Observatoire de Göttingen, fut conduit à introduire la loi normale après s’être
intéressé au problème des erreurs dans les mesures astronomiques. 21. Son argumentation part
du postulat de la moyenne : “étant données plusieurs valeurs observées d’une quantité inconnue,
la valeur la plus probable de cette quantité est la moyenne des valeurs observées”. En supposant
que les diverses observations sont représentées par des variables aléatoires indépendantes ayant
une même distribution de probabilité, il n’est pas bien difficile d’établir que la fonction corre-
spondante est une loi normale.

Remarquons que cette correspondance exacte entre la moyenne m de l’échantillon de mesures
et l’estimateur du maximum de vraisemblance n’est pas nécessairement valable pour des distribu-
tions autres que la gaussienne. Considérons par exemple la cas d’une distribution rectangulaire
sur un intervalle (a, b). L’estimateur µ∗ est égal à 1

2

[
x(1) + x(2)

]
, où x(1) et x(2) sont respective-

ment la mesure la plus faible et la mesure la plus élevée dans l’échantillon. On constate ainsi
que, dans ce cas, l’estimateur est différent de la moyenne d’échantillon m.

� Précision sur la détermination de l’estimateur de la moyenne

Si nous reproduisons l’ensemble des N mesures dans des conditions identiques, la disper-
sion des résultats conduira à des valeurs différentes x1 · · ·xN dans l’échantillon. La moyenne
d’échantillon m est par conséquent elle-même sujette à fluctuations d’une série de mesures à
l’autre. Dans l’ensemble d’une infinité virtuelle d’échantillons obtenus indépendamment les uns
des autres et dans des conditions identiques, on aura une moyenne (ou espérance mathéma-
tique), une variance et une distribution. Cette distribution de probabilité est la distribution
d’échantillonnage de la moyenne.

L’espérance E(m) et la variance V(m) = (σm)2 d’une moyenne d’échantillon m peuvent être
exprimées en fonction des paramètres µ et σ. En effet, si x1 · · ·xN sont des copies indépendantes
d’une grandeur x de moyenne µ et de variance σ, alors :

E(m) = E

(
1
N

N∑
i=1

xi

)
=

1
N

N∑
i=1

E(xi) =
1
N

× Nµ

21Ce résultat fut publié dans l’ouvrage Theoria motus corporum cœlestium (1809). Gauss (1777-1855) fut un
des derniers scientifiques à utiliser le latin pour la diffusion de ses travaux scientifiques.
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soit :
E(m) = µ

et

(σm)2 = Var(m) = Var

(
1
N

N∑
i=1

xi

)
=

1
N2

N∑
i=1

Var(xi) =
1

N2
× Nσ2

soit :

(σm)2 =
σ2

N
ou σm =

σ√
N

.

Une autre méthode d’évaluation des paramètres de la distribution d’échantillonnage de la
moyenne consiste à utiliser le principe du maximum de vraisemblance afin de déterminer l’écart-
type σθ associé à l’estimateur θ∗, lorsque celui-ci est mesuré sur un grand nombre d’échantillons.
Il n’est pas difficile de se convaincre que :

1
(σθ)

2 = −
(

∂2W

∂θ2

)
θ=θ∗

(14)

En dérivant une deuxième fois l’expression (12) par rapport au paramètre µ, nous obtenons ainsi

1
(σm)2

= −
(

∂2W

∂µ2

)
µ=〈m〉

=
N∑

i=1

1
σ2

soit σm =
σ√
N

.

Cette dernière expression, que nous avons ainsi établie de deux manières différentes, corre-
spond à un résultat que nous connaissons bien. En effet, nous avons pu constater expérimentale-
ment que la valeur moyenne de N mesures tend à se stabiliser lorsque la taille N de l’échantillon
augmente. De manière plus précise, nous venons d’établir que l’écart-type sur la moyenne de N
observations est plus petit que l’écart-type associé à une mesure unique 22, dans un rapport de
1/

√
N .

Puisqu’une augmentation du nombre de points de mesure conduit à une meilleure localisation
de la valeur moyenne, on pourrait alors penser qu’en partant d’une mesure peu précise, on puisse
très facilement augmenter la précision de celle-ci grâce à une simple répétition de la mesure. En
réalité, il n’en est rien puisque le gain dans la précision ne varie qu’en

√
N . Ainsi, réduire

l’incertitude d’un facteur 10 requiert d’effectuer 100 fois plus de mesures, et une amélioration
d’un facteur 1000 de cette même précision obligerait à reproduire un milion de fois la mesure,
ce qui est évidemment parfaitement irréaliste. Il faut également être conscient du fait que si un
ensemble répété de mesures permet effectivement de réduire l’erreur statistique, cette répétition
n’affecte en rien les éventuelles erreurs systématiques. Par conséquent, il est strictement inutile
d’augmenter le nombre de mesures dès lors que l’incertitude sur la grandeur mesurée est dominée
par des biais systématiques qui affectent la méthode de mesure choisie.

4.1.3 Estimateur de l’écart-type σ

Nous pouvons chercher de la même manière quel est le meilleur estimateur σ∗ de l’écart-type σ
de la distribution gaussienne sous-jacente. Pour cela, nous allons dériver l’Éq.(11) par rapport
au paramètre σ :

∂W

∂σ
= − N

σ
+

N∑
i=1

[(
µ − xi

σ

) (
µ − xi

σ2

)]
,

22Énonçons encore ce résultat important d’une manière différente. Nous avons supposé que les mesures indi-
viduelles de la grandeur x suivaient une distribution normale, centrée sur µ et d’écart-type σ. Si le même appareil
permet d’effectuer plusieurs déterminations indépendantes de la moyenne de N mesures, et que ces mesures ne
sont pas affectées par des erreurs systématiques, le résultat m suivra une distribution normale centrée sur µ et
d’écart-type σ/

√
N . Ce résultat est en réalité tout-à-fait général et est indépendant de la forme de la distribution

de probabilité. Il est en effet facile de montrer que pour N variables aléatoires, indépendantes et identiques,
l’écart-type de la moyenne s’obtient en divisant par

√
N celui de chacune de ces variables.
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de sorte que ∂W/∂σ = 0 donne :

(σ∗)2 =
1
N

N∑
i=1

(µ − xi)2 (15)

Comme nous ne connaissons pas la valeur moyenne “vraie” µ, le résultat de l’Éq.(15) est cepen-
dant inutilisable ! Nous pouvons penser le remplacer par l’estimateur

S2 =
1
N

N∑
i=1

(m − xi)2 . (16)

Nous devons cependant avoir une exigence dans le choix de l’estimateur. Puisque la valeur
de l’estimateur peut fluctuer d’une réalisation de l’échantillon à l’autre, une qualité que nous
devons imposer est que l’ensemble de toutes les estimations soit en moyenne égal à la valeur
exacte du paramètre correspondant de la distribution de probabilité. Ainsi, la relation E(m) = µ
nous indique que la moyenne d’échantillon m est bien un estimateur sans biais de la moyenne
µ de la distribution de probabilité. À l’inverse, le choix de S2 comme estimateur de la variance
σ2 introduit un biais, puisque E(S2) n’est pas exactement égal à σ2. On montre en effet (cf.
Annexe C) que :

E(S2) =
N − 1

N
σ2 .

Par conséquent, pour que l’estimateur s2 de la variance σ2 soit non biaisé, il faut ajuster S2

par le facteur (N − 1)/N :

s2 =
N

N − 1
S2 =

N

N − 1
× 1

N

N∑
i=1

(m − xi)2 ,

soit :

s2 =
1

N − 1

N∑
i=1

(m − xi)2 (17)

La grandeur s définie par l’Éq.() est appelée écart-type d’échantillon. Elle correspond à une
caractérisation intrinsèque de la dispersion sur notre échantillon {xi} de mesures. Insistons sur
le fait qu’elle est de nature fondamentalement différente de l’écart-type σ, puisque ce paramètre
se réfère à la loi de probabilité associée à la mesure de la grandeur x.

L’apparition du facteur N −1 dans l’expression (4.1.3) est cohérente avec le fait qu’une seule
mesure est insuffisante pour espérer pouvoir estimer l’écart-type de la distribution de probabilité
associée à la mesure, puisque nous ne connaissons pas la valeur “vraie” µ de la moyenne. Nous
pouvons également remarquer que les deux expressions

s2 =
1

N − 1

N∑
i=1

(m − xi)2 et (σ∗)2 =
1
N

N∑
i=1

(µ − xi)2

ne présentent pas de différence notable pour N � 1, puisque
√

N − 1 �
√

N et que la moyenne
arithmétique m va converger vers µ aux grands nombres.
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� Précision sur la détermination de l’estimateur de la variance

Nous devons également être conscients du fait que la valeur de l’écart-type d’échantillon s,
évaluée selon l’expression (4.1.3) va fluctuer d’un échantillon de mesures {xi} à l’autre. Pour
évaluer l’écart-type associé à cette dispersion, nous pouvons partir de l’Éq.(14), avec :

∂2W

∂σ2
=

N

σ2
− 3

σ4

N∑
i=1

(µ − xi)2 =
N

σ2

[
1 − 3

(
σ∗

σ

)2
]

de sorte que :

−
(

∂2W

∂σ2

)
σ=σ∗

=
2N

(σ∗)2
.

En remplaçant N par N − 1, nous en déduisons immédiatement la variance V(s) associée à
la détermination de l’écart-type d’échantillon s :

V(s) =
s2

2(N − 1)
(18)

Comme représenté sur la figure 14, ce résultat montre que l’écart-type d’échantillon s est
connu avec une précision relative

∆s

s
� 1√

2(N − 1)
. (19)

Si la forme de la dépendance par rapport à N ne nous étonne pas, nous voyons que pour N = 9
mesures, notre estimation s de l’écart-type σ de la distribution de probabilité est effectuée avec
une incertitude de l’ordre de 25 %. Pour un échantillon de telle “petite” taille 23, il est par
conséquent inutile d’attribuer une valeur parfaitement définie à l’écart-type d’échantillon, tel
qu’on peut le calculer à l’aide de la formule (4.1.3).

Figure 14: Précision relative sur l’écart-type d’échantillon s en fonction de la taille N de l’échantillon considéré.

Pour 5 à 6 mesures, cette précision est de l’ordre de 30 % et il faut effectuer plus de 30 mesures pour que celle-ci

devienne inférieure à 20 %.

23Alors qu’en pratique, répéter une mesure dix fois est déjà assez prenant...
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4.1.4 Cas d’un petit nombre de mesures : utilisation de la fonction de Student

Nous venons d’établir que l’écart-type d’échantillon s est un estimateur sans biais de l’écart-
type σ de la distribution de probabilité associée à la mesure. Cette approximation est d’autant
meilleure que le nombre N de points de mesure dans l’échantillon est grand et dès lors que
N > 20, il n’y a plus de différence significative entre s et σ.

Dans le cas d’un échantillon de petite taille (par exemple N < 10), les choses sont cependant
plus compliquées. Supposons en effet que l’une des mesures xk dans l’ensemble des {xi} soit
anormalement élevée, sa valeur étant a priori assez improbable compte tenu de la distribution de
probabilité. Cette mesure va alors fortement influencer d’une part la moyenne m, prise comme
estimateur de la mesure “vraie” xvraie, et d’autre part la valeur de l’écart-type d’échantillon
σ(N−1). Dans ces conditions, la probabilité P que l’intervalle [m− 2σ(N−1), m + 2σ(N−1)] conti-
enne la valeur xvraie sera inférieure à 95 %. Il est par conséquent nécessaire de revoir la procédure
d’exploitation de l’échantillon de mesures, en cherchant une distribution dont la forme soit liée à
la loi de Gauss mais qui soit cependant mieux adaptée à la situation considérée d’un échantillon
de petite taille.

Il s’agit en particulier d’obtenir l’intervalle de confiance de l’estimateur de la moyenne µ de
la distribution, en utilisant les valeurs m et s2. Nous cherchons donc la quantité e telle que :

Prob (|m − µ |≤ e) = 1 − α

soit :

Prob

(
|m − µ |

s√
N

≤ e′
)

= 1 − α avec e′ =
e
s√
N

.

Étant donné que le numérateur m − µ et le dénominateur s√
N

sont tous deux aléatoires, la loi
de probabilité de la variable

t =
x − m

s√
N

(20)

est celle d’un ratio entre deux variables aléatoires. Cette loi de probabilité n’est plus une fonction
normale comme cela est le cas quand la variance σ2 – le dénominateur du ratio – est un paramètre
fixé et connu. On montre que t suit une distribution appelée loi de Student à N − 1 degrés de
liberté et définie par :

fN−1(t) =
C(

1 + t2

N−1

)N
2

avec C =
Γ(N

2 )√
π(N − 1) Γ(N−1

2 )
(21)

où la fonction Γ(x) est l’intégrale d’Euler de deuxième espèce 24. Comme montré sur la figure
15, cette fonction a une structure relativement simple. Pour N = 2 (c’est-à-dire l’exploitation
de deux points de mesure), la fonction de Student se confond avec une lorentzienne 1/π(1+x2).
Lorsque N devient très grand, la distribution de Student tend asymptotiquement vers une dis-
tribution de Gauss normalisée 1/

√
2π × exp

(
−x2

2

)
.

Dans l’hypothèse où toute erreur systématique a été écartée et où les N mesures individuelles
{xi} sont tirées d’une distribution gaussienne plus vaste, l’intervalle de confiance de la grandeur
x qui correspond à un niveau de confiance α donné (par exemple 95 %) est alors de la forme :[

µ − tα × s√
N

; µ + tα × s√
N

]
, (22)

24Cette fonction spéciale constitue une généralisation de la fonction factorielle au cas d’un argument non-entier,
avec Γ(N + 1) = N ! pour N entier.
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Figure 15: (a) Comparaison de la distribution t de Student pour différentes valeurs du nombre N d’observations.

Lorsque N � 1, ces courbes tendent asymptotiquement vers une loi de Gauss. On notera que pour un échantillon

contenant un nombre fini de valeurs, l’utilisation de la distribution de Gauss conduit à sous-évaluer la probabilité

d’obtenir des écarts importants (par exemple supérieurs à 3σ) par rapport à la valeur moyenne. (b) On doit ces

lois à W. S. Gosset (1976–1937) qui était à l’origine employé par les célèbres brasseries Guinness afin de mettre

au point des techniques de contrôle de qualité, qui sont aujourd’hui courantes dans tout le monde industriel. Il

publia ses travaux en 1908 sous le pseudonyme de Student, car la société Guiness souhaitait préserver le secret

sur les travaux d’exploitation statistique, pensant qu’ils étaient la clé d’un avantage industriel par rapport à des

sociétés concurrentes !

expression dans laquelle le coefficient de Student tα est obtenu par intégration de la distribution
de Student pour un échantillon de taille N (c’est-à-dire à N −1 degrés de liberté). Si l’on trouve
dans tous les traités de statistique des tableaux donnant les valeurs numériques de ces coefficients,
le logiciel Igor propose deux fonctions utiles qui sont directement liées à ces distributions de
Student :

• StudentA(t,DegFree) donne l’aire de la distribution de Student correspondant à un nom-
bre DegFree de degrés de liberté, comprise entre les valeurs -t et +t ;

• StudentT(Prob,DegFree) retourne la valeur de t qui correspond à une aire Prob en-
dessous de la distribution de Student à DegFree degrés de liberté.

4.2 Un exemple d’analyse d’une série de mesures

Considérons 10 mesures successives d’une tension, effectuées à l’aide d’un même voltmètre25.
Si nous examinons les résultats obtenus, dont les valeurs sont indiquées dans le tableau ci-
dessous, nous constatons tout d’abord qu’apparemment, aucune d’entre elles ne s’écarte de
manière significative des autres. Par conséquent, nous ne pouvons déceler aucune erreur de
manipulation dans la prise de ces données et quel est alors le résultat ?

N◦ de la mesure 1 2 3 4 5 6 7 8 9 10
Valeur lue (en V) 5.11 5.10 5.08 5.08 5.07 5.10 5.10 5.10 5.10 5.11

4.2.1 Premier niveau d’analyse

Il est logique de supposer que la vraie valeur de la tension se trouve quelque part, entre la valeur
maximale Umax = 5.11 V et la valeur minimale Umin = 5.07 V. On trouvera parfois écrit (ou dit

25Cet exemple est tiré du polycopié de TP d’André Galais sur le traitement et l’analyse des données.
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lors de la présentation d’un montage) que l’écart entre ces deux valeurs donne une estimation
de l’erreur ∆U , et que leur moyenne donne une valeur “probable” de la grandeur mesurée :

Uprobable =
Umax + Umax

2
= et ∆U =

Umax − Umax

2
,

ce qui revient à donner le résultat de la mesure suivant :

U = (5.09 ± 0.02) V .

Cette analyse est évidemment simple et rapide. Nous espérons cependant vous avoir con-
vaincu qu’elle est sans fondement, et que le résultat ainsi énoncé n’a aucune réelle valeur sci-
entifique. En particulier, si on réalisait une nouvelle mesure de cette tension, rien n’interdirait
d’obtenir un résultat dont la valeur soit située nettement en dehors de l’intervalle écrit ci-dessus.
Même si ce type d’analyse donne des résultats “acceptables”, il faut donc une fois pour toutes
y renoncer et lui préférer une exploitation statistique de la série de mesures.

4.2.2 Deuxième niveau d’analyse : étude statistique de la série de mesure

Nous allons maintenant voir comment une analyse statistique de cet échantillon de mesures peut
être effectuée simplement à l’aide du logiciel Igor. Après avoir créé la wave tension contenant
les dix valeurs mesurées, nous allons tout d’abord nous faire une idée sur la répartition de ces
valeurs. Allons pour cela dans le menu Analysis → Wave Stats..., ou tapons directement la
commande correspondante WaveStats Tension dans la ligne de commande. Nous voyons alors
s’imprimer dans la fenêtre d’histoire les renseignements suivants :

V−npnts= 10; V−numNaNs= 0; V−numINFs= 0; V−avg= 5.095;
V−sdev= 0.0135401; V−rms= 5.09502; V−adev= 0.011;
V−skew= -0.604267; V−kurt= -1.22603; V−minloc= 4; V−min= 5.07;
V−maxloc= 0; V−max= 5.11;

Parmi ces différentes variables dont on trouvera la signification dans la documentation du logi-
ciel [1], V−avg et V−sdev donnent respectivement la valeur moyenne d’échantillon m = 5.095 et
l’écart-type d’échantillon s = 0.0135401.

Nous allons ainsi pouvoir exprimer le résultat de ces mesures sous la forme d’un intervalle
de confiance, en utilisant la distribution de Student. Pour N − 1 = 9 degrés de liberté, la valeur
de tα correspondant à un niveau de confiance de 95 % peut être obtenue grâce aux tables. Nous
pouvons également utiliser le logiciel et la fonction pré-définie StudentT :

print StudentT(0.95,9)
2.26214

de sorte que :

tα × s√
N

= 2.26214 × 0.0135401√
10

= 0.009686 .

Nous avons maintenant tous les éléments pour donner le résultat sous la forme :

U = m ± ∆U soit U = (5.095 ± 0.010) V

Compte tenu de l’arrondi, cet intervalle correspond à un niveau de confiance légèrement supérieur
à 95 % pour les 10 mesures effectuées.

Remarquons que si nous n’avions pas tenu compte du facteur correctif introduit par la
distribution de Student, nous nous serions contentés de donner l’incertitude sur la moyenne des
10 mesures pour un intervalle de probabilité de 95 % comme

2 × s√
N

� 0.0086 V .
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Comme nous avons montré précédemment que l’évaluation de l’incertitude est effectuée à environ
25 % près, nous pouvons tout aussi bien lui donner une valeur comprise entre 0.0064 V et
0.0107 V. L’intervalle de confiance déterminé à partir du coefficient de Student recouvre ces
valeurs et c’est par conséquent celui que nous conserverons pour la suite. Enfin, nous pouvons
noter que le premier niveau d’analyse, qui consiste à prendre les valeurs extrêmes de la série
de mesures comme bornes d’intervalle fictif qui contiendrait la vraie valeur conduit à une très
forte surestimation de l’incertitude sur la mesure, supérieure à l’incertitude effective ∆s sur
l’écart-type.

� Comparaison avec la distribution gaussienne estimée

Si cette analyse est rigoureuse et donne un résultat final quantitatif, on peut cependant lui
reprocher de supposer implicitement que les mesures de la tension U sont distribuées suivant
une loi normale de Gauss. Nous pouvons par conséquent nous interroger sur la justesse de cette
hypothèse, et chercher des critères quantitatifs qui nous permettraient de la tester. Une première
méthode qualitative peut être de simplement tracer l’histogramme des points de mesure, en
choisissant un pas 26 approprié (ici δVbin = 0.01 V).

– Tracer l’histogramme donnant la répartition des valeurs de la tension. Créer pour cela une
wave tension histo. Sélectionner le menu Analysis > Histogram. Dans la fenêtre qui
apparâıt, préciser la wave de départ (tension), la wave de destination (tension histo), le
bin start (5), la largeur du pas (0.01) et le nombre de pas (20). La taille et l’échelle de la
wave (tension histo) sont alors automatiquement calculées. Représenter graphiquement
(tension histo). On obtient un histogramme en sélectionnant le mode Bars to next à la
place de Line between points pour l’affichage de la courbe.

Nous pouvons ensuite superposer à cet histogramme la distribution de probabilité déterminée
à partir de l’échantillon de mesures. La probabilité d’obtenir une valeur Ulue de la tension, avec
le pas δVbin choisi, va alors s’écrire :

P(Ulue) =
1

s
√

2 π
exp

[
−(Ulue − m)2

2s2

]
× δVbin

=
1

0.0135 ×
√

2 π
exp

[
−(Ulue(V) − 5.095)2

2 × (0.0135)2

]
× 0.01 . (23)

L’histogramme des valeurs de l’échantillon et la loi de Gauss correspondante N ×P(Ulue), où le
facteur N correspond au nombre total de points de mesure dans l’échantillon, sont représentés
sur la figure 16. Compte tenu de la faible statistique, l’échantillon contenant seulement 10
mesures, il est évidemment difficile d’exploiter cette simple représentation pour se convaincre ou
non de la validité de l’hypothèse d’une répartition des mesures effectuées selon la loi normale
de Gauss. Nous verrons que le test du χ2 nous permettra de rendre ces considérations plus
quantitatives.

4.2.3 Un peu de vocabulaire de métrologie : budget d’incertitude d’une mesure

L’incertitude ∆U que nous venons d’évaluer est celle sur la moyenne m des dix mesures. Elle ne
correspond pas à celle qui affecte une mesure unique de la tension, laquelle est caractérisée par
l’écart-type σ dont s est un estimateur non biaisé. Ainsi, l’intervalle de confiance de 95 % pour
une mesure unique de la tension U sera donné comme [ m − 2s ; m + 2s ], soit [5.081 V ; 5.109 V].

Dans le langage des métrologues, nous venons d’utiliser une méthode d’évaluation de type A
de l’incertitude [3]. Cette dénomination correspond par définition à une technique d’évaluation

26En anglais, bin.
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Figure 16: Histogramme des mesures de la tension, tracé pour un pas d’échantillonnage de 0.01 V, et distribution

de probabilité associée, tracée en pointillé. Cette courbe correspond à une gaussienne avec comme paramètres

les valeurs des estimateurs m et s obtenus à partir de l’exploitation de l’échantillon de mesures. Les points (•)
correspondent aux occurences calculées pour chaque valeur de la tension obtenue dans l’échantillon considéré.

de l’incertitude à partir d’un procédé statistique qui prend en compte la dispersion des résultats
observée lorsqu’on répète à l’identique une mesure.

Les métrologues définissent également les méthodes d’évaluation de type B, lesquelles corre-
spondent a contrario à toutes les techniques d’évaluation de l’incertitude qui ne sont pas basées
sur une procédure d’exploitation statistique d’un échantillon de mesures. L’évaluation de ce
type d’incertitude s’appuie en général sur un jugement scientifique élaboré à partir d’une anal-
yse physique de l’expérience. Il faut en particulier cerner la part d’incertitude qui est due à
chacune des corrections associées aux différentes causes d’erreur qui ont été identifiées. On ap-
plique le même formalisme que pour les méthodes de type A, à savoir évaluer l’incertitude par
une valeur ∆Uk qu’on peut traiter comme un écart-type. Cette valeur est déterminée à partir
d’éléments qui peuvent provenir d’une bibliographie sur les matériaux et les capteurs utilisés
dans l’expérience, de notices des constructeurs, d’éventuels certificats d’étalonnage, etc. mais
également à partir des connaissances et du savoir-faire de l’expérimentateur 27. Pour ensuite
obtenir l’incertitude ∆U (B) (évaluée comme un écart-type) sur la correction totale, on applique
la loi de composition des variances. Dans l’hypothèse où causes d’erreur et corrections ne sont
pas corrélées, celle-ci s’écrira :

∆U (B) =
√∑

k

(∆Uk)
2 . (24)

On peut également convenir de donner une incertitude globale en introduisant un facteur mul-
tiplicatif conventionnel ×2, lequel correspond pour une loi normale de Gauss à la donnée d’un
intervalle à risque d’erreur inférieur à 5 %.

27On notera que cette manière de procéder revient, pour certains cas, à postuler l’existence sous-jacente d’une
loi de distribution pour la correction considérée.
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� Incertitude composée sur la mesure

L’incertitude composée ∆Utot va tenir compte des incertitudes ∆U (A) et ∆U (B) évaluées
respectivement par les méthodes de type A et B. Elle est obtenue en composant les variances,
c’est-à-dire pour des mesurages bruts et indépendants :

(∆Utot)
2 =

(
∆U (A)

)2
+

(
∆U (B)

)2
soit (∆Utot)

2 =
s2

N
+

(
∆U (B)

)2
. (25)

L’incertitude finale sur le résultat sera ensuite donnée par la racine carrée de cette variance.
Cette expression montre également que l’incertitude de type B affecte de la même manière une
mesure unique et la valeur moyenne d’un échantillon de mesures. Contrairement à l’incertitude
de type A, ce type d’incertitude ne peut être réduit par le moyennage d’une série de mesures
répétées. Tout l’art du physicien “métrologue” sera alors de chercher à identifier le mieux
possible les différentes causes d’erreur qui affecte la mesure qu’il réalise. La coutume est de
présenter les deux types de contributions sous la forme d’un budget d’incertitude.

� Budget d’incertitude de la mesure

Ces concepts peuvent sembler très abstraits. Nous allons les illustrer et montrer comment
il est possible de les mettre en œuvre à travers l’exemple des dix mesures de la tension. Celles-
ci ont été effectuées au moyen d’un multimètre numérique Tektronix dmm 912 dont nous
disposons au laboratoire. Nous avons évalué la dispersion associée à la répétabilité des mesures,
représentée par une incertitude

∆U (A) = 9.2 mV .

L’incertitude de type B sera quant-à elle due à l’étalonnage du voltmètre et à la limitation
imposée par la résolution de l’appareil numérique, soit :

∆U (B) = 2 × ( 0.2% VL + 1 UL )

où VL correspond à la valeur lue (5.10 V) et UL à une unité du dernier chiffre exprimant la
mesure. Le multimètre ayant 2000 points et étant utilisé sur le calibre 10 V, UL correspond à 5
mV. On obtient ainsi un budget d’incertitude qu’on peut représenter par le tableau ci-dessous :

Composantes évaluées par l’analyse statistique en V
Exploitation de 10 mesures répétées de la tension
∆U (A) (incertitude de type A sur la moyenne des 10 mesures) 0. 009 7
Composantes évaluées par d’autres moyens en V
Étalonnage du multimètre (0.2 % de la valeur lue) 0. 010 2
Résolution du multimètre (1 unité de lecture) 0. 005 0
∆U (B) (incertitude de type B élargie à 2σ) 0. 030 4
Incertitude totale en V

∆Utot =
√(

∆U (A)
)2 +

(
∆U (B)

)2 (valeur élargie à 2σ) 0. 032 1

Le résultat final de la mesure, qui prend en compte les deux types d’incertitudes, sera ainsi
donné comme :

U = (5.095 ± 0.032) V .

À la lumière du budget d’incertitude, nous avons montré que la précision de la mesure était
essentiellement fixée par la calibration du multimètre. On se convaincra du fait qu’avec un peu
d’entrâınement et l’habitude d’un travail méthodique, une telle analyse puisse être effectuée très
rapidement.
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5 L’ajustement de courbes expérimentales

5.1 Données et moindres carrés

5.1.1 Position du problème

Nous avons vu dans la partie précédente comment il est possible d’exploiter une série de mesures
correspondant à la détermination directe d’une grandeur comme la tension, l’intensité, la po-
sition d’un objet... Dans son travail, le physicien expérimentateur est cependant très souvent
confronté à un problème de nature un peu différente 28. Lorsqu’on réalise une expérience, on est
amené à mesurer une grandeur y en fonction d’une autre grandeur x, soit qu’il s’agisse d’établir
une loi empirique, soit qu’il s’agisse d’utiliser une loi connue pour déterminer une grandeur in-
connue. Ainsi, on peut chercher à établir la relation entre la pression et le volume d’un gaz
à température constante, déterminer comment varie le gain électronique d’un amplificateur en
fonction de la fréquence du signal d’entrée... On possède également une théorie qui prédit la loi
y(x) et l’on cherche à savoir si la théorie est juste. C’est bien là l’essence même d’une modélisa-
tion de l’expérience, où on cherche à faire entrer les mesures dans le cadre théorique et prédictif
d’un modèle, et à valider les hypothèses physiques sur lesquelles il repose.

En général, la loi issue de la théorie va également dépendre de paramètres dits “ajustables”,
dont on ne connâıt pas la valeur a priori et que l’on va tenter d’ajuster afin d’obtenir le meilleur
accord possible avec les données expérimentales. Ainsi, on est amené à poser deux questions
distinctes :

(1) Est-ce que la théorie marche ?

(2) Quelles sont les valeurs des paramètres ajustables, et les incertitudes associées ?

Compte tenu de l’importance de ce problème, nul ne doutera de l’intérêt de regarder d’un peu
plus près comment un logiciel comme Igor peut être utilisé pour répondre à ces questions, et
quels sont les algorithmes qu’il utilise. Nous pouvons également nous demander quelles sont les
hypothèses sous-jacentes, et surtout quelles sont les éventuelles limites de ce type d’exploitation.

5.1.2 L’hypothèse de départ

En pratique, l’expérimentateur relève, pour N points de mesure {xi}i=1···N , les N valeurs
{yi}i=1···N correspondantes. Supposons que l’on dispose d’une loi théorique qui donne y en
fonction de x. Les valeurs correspondantes, que nous noterons y sont supposées être fonction de
la variable x et d’un certain nombre de paramètres α1, · · · , αm. Nous écrirons par conséquent :

yi = y(x; α1, · · · , αm) = y(x; {αj}) (26)

Nous supposerons par ailleurs que chaque résultat mesure yi est affecté d’une incertitude carac-
térisée par un écart-type σi, comme représenté sur la figure 17

Ce qui nous intéresse, ce sont les écarts entre les yi mesurés et les valeurs calculées à l’aide
de la théorie pour les différentes valeurs xi. On définit ainsi la quantité “chi-deux” comme :

χ2({αj}) =
N∑

i=1

[yi − y(xi; {αj})]2
σ2

i

. (27)

Nous cherchons alors l’ensemble des paramètres α1, α2, . . . qui rendra χ2 le plus petit possi-
ble. C’est pour cette raison que la méthode porte le nom d’“ajustement par moindres carrés”
puisque χ2 est défini comme la somme (pondérée par l’incertitude) des carrés des écarts entre

28Cette partie est très largement inspirée de la Réf. [7], dont nous recommandons la lecture.



y

x
x1 x2 x3 x4

5.2 Ajustement d’une fonction linéaire 33

Figure 17: Ajustement d’une loi y(x) à un ensemble de données de mesure (x1, y1), (x2, y2), . . . Chaque valeur

de y est déterminée avec une incertitude ∆y, cette précision sur les mesures étant représentée par la barre d’erreur

sur le graphique y(x).

les mesures et les valeurs théoriques calculées.

Remarquons que nous aurions pu choisir autre chose que la somme des carrés des écarts, par
exemple la somme des valeurs absolues ou la borne supérieure des carrés. La justification du
choix que nous avons fait repose en fait sur l’hypothèse que chaque mesure individuelle yi est
tirée d’une distribution gaussienne sous-jacente dont la valeur moyenne est donnée par la valeur
vraie de yi, y(x; {αj}). Pour l’écart-type de cette loi de Gauss, nous prendrons naturellement
l’écart-type σi associé à l’incertitude sur chacun des yi. La distribution de probabilité va alors
s’écrire

f(yi ; xi ; {αj}) =
1

σi

√
2π

exp

{
−1

2

[
yi − y(xi; {αj})

σi

]2
}

(28)

Par analogie avec l’Éq.(8), la fonction de vraisemblance va s’écrire

L(y1 · · · yN ; x1 · · ·xN ; {αj}) =
N∏

i=1

f(yi ; xi ; {αj})

et nous cherchons les estimateurs α∗
j qui rendent maximale cette fonction, ou plutôt son loga-

rithme W = lnL. Compte tenu de la définition de L, celui-ci va s’écrire :

W = −
N∑

i=1

ln
(
σi

√
2π

)
− 1

2

N∑
i=1

[
y(xi; {αj}) − yi

σi

]2

. (29)

Puisque les valeurs des σi sont fixées par la méthode de mesure, les estimateurs α∗
j vont cor-

respondre aux valeurs des paramètres αj qui rendent minimale la somme des carrés des écarts
χ2({αj}) définie par l’Éq.(27).

5.2 Ajustement d’une fonction linéaire

5.2.1 Ajustement sans prendre en compte d’incertitudes

Considérons pour commencer le cas le plus simple d’une dépendance affine y = ax + b, où les
deux paramètres ajustables sont a et b. Nous supposerons également que chaque mesure a le
même poids statistique, de sorte que nous cherchons a et b tels que

χ2 =
N∑

i=1

(axi + b − yi)
2 (30)
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soit minimum. il faut pour cela que les dérivées de χ2 par rapport aux deux paramètres soient
nulles :

∂χ2

∂a
=

N∑
i=1

2xi(axi + b − yi) = 0

∂χ2

∂b
=

N∑
i=1

2(axi + b − yi) = 0

de sorte que les valeurs de a et b sont obtenues par la résolution de deux équations :

a
N∑

i=1

x2
i + b

N∑
i=1

xi =
N∑

i=1

xiyi

a
N∑

i=1

xi + bN =
N∑

i=1

yi

On notera que la dernière équation montre que la fonction obtenue par cet ajustement va néces-
sairement passer par le point dont les coordonnées suivant x et y correspondent respectivement
aux moyennes xm et ym des échantillons {x1 · · ·xN} et {y1 · · · yN} :

xm =
1
N

N∑
i=1

xi et ym =
1
N

N∑
i=1

yi . (31)

Quelques lignes de calcul suffisent ensuite à déterminer les valeurs de a et b :

a =
∑N

i=1 xi(yi − ym)∑N
i=1 xi(xi − xm)

et b = ym − axm . (32)

Lire dans un fichier ou dans une mémoire les N valeurs de x et y , puis effectuer ces calculs
pour obtenir la droite d’ajustement par moindres carrés est donc extrêmement simple. On
comprend pourquoi cette fonction est disponible sur toutes les calculatrices scientifiques, et
qu’elle est également proposée dans tous les tableurs.

5.2.2 Incertitudes sur les paramètres de l’ajustement

Il y a évidemment une faiblesse criante dans ce que nous avons fait jusqu’à présent, puisque
nulle part ne figure d’incertitude sur cet ajustement. Plus précisément, nous aimerions con-
nâıtre l’incertitude sur les paramètres a et b qui résulte de l’écart-type σ sur les mesures de
la grandeur y. Imaginons pour cela la réalisation de nouvelles mesures de la grandeur y cor-
respondant aux mêmes N valeurs de xi. Nous obtiendrions alors un nouvel échantillon de
valeurs (y′1 · · · y′N ), de sorte que l’ajustement par moindres carrés des nouveaux couples de points
{(x1, y

′
1) · · · (xN , y′N )} conduirait à de nouvelles valeurs a′ et b′ de la droite d’ajustement. En

supposant que chaque yi est tiré au sort à partir d’une loi normale centrée sur la valeur vraie yi

correspondant à xi et d’écart-type σ (figure 18), les paramètres xi et yi sont reliés par :

yi = a xi + b (33)

où a et b correspondent aux valeurs vraies des paramètres d’ajustement. Si nous ne sommes pas
capables de connâıtre ces valeurs puisque nous disposons d’un seul ensemble de mesures, nous
voulons pouvoir estimer les erreurs standard sur les valeurs de a et b données par l’Éq.(32) :

(∆a)2 = 〈(a − a)2〉 et (∆b)2 = 〈(b − b)2〉 . (34)

À partir de la dispersion des valeurs de y par rapport à celles estimées par le modèle, il est
possible de faire une estimation des incertitudes ∆a et ∆b. Nous reviendrons sur ce point dans
le TP suivant.
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Figure 18: Mesures répétées pour un ensemble fixé x1, x2, . . . de valeurs de la grandeur x. Pour chaque valeur

xi, le résultat yi de la mesure forme une distribution normale centrée sur la valeur vraie yi. Les mesures étant

supposées avoir le même poids statistique, chaque distribution a le même écart-type σ. Chaque nouvel ensemble

de mesures {(x1, y1), (x2, y2) · · · yN )} correspondra à une nouveau jeu de valeurs des paramètres a et b de la droite

d’ajustement y = ax + b, alors que l’ajustement vrai correspond quant-à lui à la droite d’équation y = ax + b.

Cette droite passe par les points {(x1, y1), (x2, y2) · · · (xN , yN )}.

5.3 Ajustement par une fonction polynômiale

On peut généraliser facilement les équations précédentes au cas d’un polynôme de degré p :

P (x) = c0 + c1x + c2x
2 + · · · + cpxp =

p∑
j=0

cjx
p .

On cherche bien sûr les coefficients cj et par conséquent :

∂χ2

∂cj
=

∂

∂cj


 N∑

i=1

{ p∑
k=0

(
ck xi

k − yi

)}2

 = 0 .

On peut se convaincre aisément que le problème va en fait se ramener à un système linéaire
de p équations à p inconnues (les ck), et dans tous les cas on obtiendra une solution pour les
paramètres de l’ajustement.

Si une telle procédure est commode pour modéliser une courbe d’étalonnage sans avoir
besoin de connâıtre un quelconque modèle physique, nous pouvons nous demander s’il s’agit de
la méthode générique d’ajustement. Poser la question est évidemment un début de réponse.
Il suffit de considérer les équations de ce chapitre pour constater que cette méthode donnera
toujours un résultat, si absurde soit-il. La figure 19 montre un exemple d’un ajustement de
données expérimentales par une loi quadratique y = a + bx + cx2, dont on peut douter de l’à-
propos... Moralité : ce n’est pas parce qu’un programme d’ajustement par moindres carrés donne
un résultat que le modèle est validé et que les paramètres donnés par le calcul algorithmique
sont effectivement pertinents vis-à-vis du problème physique considéré.
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Figure 19: Un exemple d’ajustement. La figure (a) repérsente l’abondance relative d’abeilles “africanisées”

(axe horizontal) et d’abeilles sans dard (axe vertical), et l’ajustement de ces données par un polynôme du second

degré. Cette courbe est tirée d’un article publié en 1978 dans la revue prestigieuse Nature. La figure (b) propose

un autre type d’ajustement...

5.4 Un exemple d’ajustement de données expérimentales

5.4.1 Position du problème

La courbe représentant la résistance d’une thermistance en fonction de la température que nous
avons tracée précédemment peut être ajustée par une loi exponentielle de la forme :

R(T ) = R0e
Egap
2kBT . (35)

Nous voulons ajuster la série de mesures données dans le tableau 1 sur ce modèle. Nous pourrons
ainsi estimer d’une part la valeur de R0 et d’autre part celle de l’énergie caractéristique Egap

qui correspond à l’énergie “de gap” du matériau semiconducteur utilisé dans la thermistance.
Nous pouvons pour cela procéder de deux manières différentes :

– Nous ramener à une loi affine, l’ajustement pouvant ensuite être effectué par la méthode
des “moindres carrés” décrite précédemment. Il nous suffit d’effectuer les changements de
variable y = lnR et x = 1

T dans l’Éq.(35), qui s’écrira alors :

y =
Egap

2kB
x + lnR0

Les paramètres Egap

2kB
et ln R0 tiendront alors le rôle de a et b dans l’ajustement par la

méthode des moindres carrés.

– Ajuster directement la courbe donnant la résistance R en fonction de la température T .
La méthode d’ajustement sera alors fondamentalement différente.

5.4.2 Ajustement des données avec une fonction affine

Nous allons réaliser l’ajustement des valeurs de lnR en fonction de 1/T .
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– Taper sur la ligne de commande :
Duplicate resistance ln resistance
ln resistance=ln(resistance)
Duplicate temperature inv temperature
inv temperature=1/temperature

– Représenter graphiquement la wave ln resistance en fonction de inv temperature.

– Cliquer sur le graphique puis sur le menu Analysis > Curve Fitting. Dans la fenêtre qui
apparâıt, sélectionner la fonction (Line), Y data (ln resistance), X data (inv tempetature)
et cliquer sur Do It.

L’ajustement est alors effectué en suivant la méthode des moindres carrés. Les valeurs des
paramètres de la fonction d’ajustement y = a+bx apparaissent dans l’historique de l’expérience

Coefficient values ± one standard deviation
a = -9.2626 ± 0.121
b = 4230.6 ± 42.3

À partir de la valeur de b, on peut en déduire la valeur du paramètre Egap, qu’il est commode
d’exprimer en eV :

print 2*4230.6*1.38*10^(-23)/(1.6*10^(-19))
0.729779

Afin de se rendre compte de la qualité de l’ajustement, il est conseillé de demander l’affichage
des résidus yi − y(xi; {a, b}) de l’ajustement (fit residuals), comme cela est représenté sur la
figure 20. Le fait que les résidus soient répartis aléatoirement de part et d’autre de la valeur
nulle donne confiance dans la qualité de l’ajustement, et la justesse du modèle utilisé pour
représenter les données numériques. Nous verrons que cet argument qualitatif peut être rendu
quantitatif, à l’aide du calcul du χ2 de l’ajustement.

Figure 20: Ajustement des données expérimentales de la variation de résistance R en fonction de la température

T pour une thermistance.

� Quelques remarques

(a) On peut procéder à un ajustement d’une partie d’une courbe seulement, en rajoutant
deux curseurs A et B qui définiront la partie de la courbe que l’on souhaite ajuster au
modèle, et en cliquant sur le bouton Cursors dans l’intercalaire Data Options.

(b) Lors de l’ajustement, on peut fixer la valeur de un ou plusieurs paramètres. On peut en
particulier forcer l’ajustement d’une fonction y = ax+b à passer par l’origine (x = 0, y = 0),
en fixant b = 0 dans les valeurs des paramètres d’ajustement.
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5.5 Ajustement non-linéaire

5.5.1 Position du problème

Ce qui rend l’ajustement de lois affines, et par extension de polynômes, si simple, c’est que
la dépendance d’un polynôme par rapport aux paramètres qui le composent est linéaire : la
fonction y = a + bx2 + cx2 est linéaire en a, b et c, même si ce n’est pas une fonction linéaire de
la variable x. dans l’exemple considéré, nous pouvons chercher à ajuster directement la courbe
qui donne la résistance R en fonction de la température T , selon une fonction du type

R = A × eB/T .

Les paramètres que l’on souhaite ajuster sont A et B or la fonction n’est linéaire ni en A ni en
B. On doit utiliser un algorithme d’ajustement non-linéaire qui fonctionne selon la procédure
suivante. Imaginons qu’on cherche à trouver le fond d’une vallée la nuit et dans le brouillard. À
partir d’un point de départ donné, on suit naturellement la direction de plus grande pente pour
descendre, et on continue à le faire jusqu’à aboutir à un minimu “local”. Bien évidemment, si
on fait un pas “de géant”, il se peut qu’on passe par-dessus le fond de la vallée. À l’inverse,
plus on arrive vers le fond de la vallée et plus il est nécessaire de faire des petits pas pour
être sûr de bien localiser le minimum. Dans la recherche du minimum du χ2 de l’ajustement,
Igor utilise l’algorithme de Levenberg–Marquardt qui est une méthode numérique astu-
cieuse et efficace pour définir la taille du pas au fur et à mesure qu’on se rapproche du minimum.

Attention cependant ! Ce n’est pas parce que cette méthode est intégrée dans le logiciel
qu’elle est infaillible. Si le point de départ de la recherche, c’est-à-dire les valeurs proposées
initialement pour les paramètres de l’ajustement 29, est trop éloigné de la solution, le résultat
obtenu risque d’être absurde ou bien l’algorithme risque de ne jamais converger. Un autre danger
est d’utiliser un trop grand nombre de paramètres ajustables, chaque paramètre ajoutant une
dimension à l’espace de recherche. La signification du résultat final risque d’être assez discutable.

Ainsi, lorsqu’on ajuste un modèle théorique à des données expérimentales, on est donc con-
fronté à deux types de difficultés:

– La recherche du minimum de χ2, sachant qu’il est parfois difficile de prouver que le mini-
mum trouvé par le logiciel est bien le véritable minimum de la fonction ;

– Le fait que d’avoir trouvé le minimum de χ2 ne valide en aucun cas le modèle utilisé.

C’est en fait le bon sens du physicien, et surtout son analyse critique, qui permet d’avoir confi-
ance dans l’ajustement. On doit considérer les paramètres de l’ajustement comme des grandeurs
physiques, voir si l’ordre de grandeur obtenu au moyen de l’ajustement est effectivement correct,
vérifier si une modification d’un paramètre donné entrâıne bien une variation dans le sens qu’on
observe expérimentalement, etc.

Indépendamment de l’utilisation d’un algorithme d’ajustement non-linéaire, il existe au reste
une première méthode efficace pour tester la validité d’un modèle. Une bonne habitude est de
tracer sur un même graphe la courbe théorique et les résultats expérimentaux pour voir “à l’œil”
si ça ressemble 30 ! On peut pousser un peu plus loin l’analyse en traçant en parallèle la courbe
des écarts entre fonction théorique et points de mesure. L’ajustement des valeurs des paramètres
du “fit” se fait alors par une procédure essai–erreur, qui converge plus ou moins rapidement...

29C’est là une différence fondamentale par rapport à l’ajustement d’un polynôme, où les valeurs des paramètres
sont déterminées directement par la résolution d’un système linéaire d’équations.

30Le logiciel Igor offre cette possibilité une fois la fonction de “fit” définie.
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5.5.2 Retour sur l’étude de la thermistance

Nous allons maintenant ajuster directement la courbe donnant la resistance en fonction de la
temperature. Il faut pour cela commencer par définir la fonction A × exp(B/T ).

– Cliquer sur le menu Analysis > Curve Fitting puis sur le bouton New Fit Function,
puis remplir les différents champs dans la fenêtre qui s’ouvre alors (nom de la fonction
thermistance, paramètres A et B, variable T et fonction f(T )).

– Procéder de la même façon qu’avec une fonction prédéfinie, en sélectionnant la fonction
thermistance. Il est maintenant nécessaire de donner une estimation des paramètres A et
B dans le troisième intercalaire, avant de cliquer sur Do it. On peut rentrer par exemple
A=1 et B=4000.

On obtient alors :
Coefficient values ± one standard deviation
A = 8.0278e-05 ± 9.35e-06
B = 4285.1 ± 36.7

Au cas où le fit viendrait à ne pas converger, il faut essayer à nouveau avec d’autres valeurs
initiales pour les paramètres A et B.

6 Interfaçage d’un oscilloscope numérique TDS 210

6.1 Généralités

Il est possible de transférer des oscillogrammes enregistrés avec l’oscilloscope numérique Tek-
tronix TDS 210 directement dans le logiciel Igor, à partir du fichier Igor intitulé
“IEEE–Tektro–TDS210.pxt”. L’interfaçage entre l’oscilloscope et l’ordinateur (Mac ou PC) se
fait par l’intermédiaire du bus IEEE–GPIB, les ordinateurs étant équipés d’une carte National
Instruments (modèle NI–488) 31.

6.2 Vérification des adresses

Vérifier l’adresse fixée pour l’adressage de l’oscilloscope numérique. Pour cela, aller dans le
menu [Utility]→ [Options]→ [Config GPIB]. On peut alors choisir l’adresse de l’appareil
(par défaut [1]) et le type de liaison de l’oscilloscope avec l’ordinateur [Parler/Ecouter].

6.3 Utilisation des macros Igor

On clique sur le fichier “IEEE–Tektro–TDS210.pxt”. Celui-ci commence par exécuter la procé-
dure qui définit l’ensemble des macros nécessaires à cet interfaçage 32.

1. Aller dans le menu [Macros]→ [Setup GPIBScope]. On voit alors s’afficher une fenêtre
qui permet de définir les paramètres de liaison (figure 21).
Les deux paramètres “gpib0” et “dev1” correspondent respectivement à l’adresse de la
carte IEEE et à celle de l’oscilloscope, qui a été définie comme indiquée précédemment.
Lorsqu’on clique sur le bouton [Continue]→, les commandes correspondantes s’éxécutent
et le résultat s’affiche dans la fenêtre d’Igor.
Si un message d’erreur apparâıt, c’est qu’une des adresses n’a pas été correctement définie.
On peut également tester si la liaison IEEE fonctionne correctement.

31Les drivers correspondants fournis par National Instruments doivent être installés. L’extension NIGPIB (Igor
External Operation – XOP) du logiciel Igor est par ailleurs nécessaire pour pouvoir adresser directement la carte
d’interfaçage IEEE.

32Cette extension d’Igor a été écrite par Jean Hare (Laboratoire Kastler Brossel, ENS) pour le besoin des
expériences sur les microsphères de silice.
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Figure 21: Paramètres du menu [Setup GPIBScope]permettant de définir les paramètres de la liaison IEEE

entre l’oscilloscope et la carte d’acquisition.

2. Aller dans le menu [Macros]→ [Setup ScopeWindow]. On voit alors s’afficher une
fenêtre qui permet de transférer les données correspondant aux deux oscillogrammes Chan-
nel 1 et Channel 2 (figure 22). Il suffit de cliquer sur le bouton [Read Channels].

Figure 22: Menu [Setup ScopeWindow], permettant de récupérer les oscillogrammes.

3. Après un certain temps, on voit apparâıtre ces deux voies à l’écran de l’ordinateur, avec
la base de temps correspondant au balayage de l’oscilloscope (figure 23).

Les données sont stockées dans deux “waves” définies automatiquement, et intitulées [runX–
ch1]et [Setup runX–ch2], la valeur X correspondant à un nombre qui s’incrémente automique-
ment à chaque nouveau transfert de données. Ces “waves” peuvent ensuite être utilisées pour
exploiter de manière quantitative les mesures. On notera que l’échelle (ce que nous avons appelé
le “scaling”) associées à ces “waves” est définie automatiquement à partir du balayage de la base
de temps de l’oscilloscope.
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Figure 23: Récupération des deux oscillogrammes dans Igor. On notera que le transfert des données s’effectue à

la volée. Si on effectue un moyenne sur l’oscilloscope, il faut prendre garde à l’arrêter [RUN/STOP]→ [STOP]

avant de venir lire les valeurs qui ont été numérisées par l’oscilloscope.

6.4 Relecture des informations récupérées

Les différents “runs” d’enregistrement d’oscillogrammes peuvent être directement rappelés à
l’écran grâce à la commande [BrowseWindow]du menu → [MPacro](figure 24). Il est égale-
ment possible de rajouter des commentaires pour chacune des deux voies.

Figure 24: Rappel d’un “run”.

À partir d’une succession de tels enregistrements, on peut ainsi constituer l’équivalent d’un
cahier de laboratoire dans lequel toutes les mesures qui ont été effectuées sont conservées les
unes à la suite des autres.
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A Quelques rudiments de statistique

Considérons une variable aléatoire X associée à une distribution de probabilité P (X, x), telle que
dP = P (X, x)dx est la probabilité élémentaire pour que le tirage de la variable X se fasse entre
x et x + dx. Nous ferons l’abus de langage traditionnel du physicien, qui consiste à confondre
le nom de la variable aléatoire X avec celui de son échantillon x réel. La fonction, maintenant
notée P (x), peut être caractérisée par la fonction caractéristique ϕx(t), définie par :

ϕx(t) = 〈eitx〉 soit ϕx(t) =
∫ +∞

−∞
P (x)eitxdx (36)

avec t réel. En développant eitx en série entière, on obtient :

ϕx(t) =
∞∑

n=0

(it)n 〈xn〉
n

(37)

de sorte que la connaissance de ϕx(t) permet d’avoir directement les moments 〈xn〉 de la variable
aléatoire, sans qu’il soit pour autant nécessaire de disposer d’une expression explicite de la
fonction de distribution P (x). Nous pouvons également noter que :

(
dϕx(t)

dt

)
(t = 0) = i〈x〉

(
d2ϕx(t)

dt2

)
(t = 0) = −〈x2〉 · · ·

(
dnϕx(t)

dtn

)
(t = 0) = in〈xn〉

offrant ainsi une manière simple pour calculer les moments :

〈xn〉 =
1
in

(
dnϕx(t)

dtn

)
(t = 0) . (38)

� Cas de la distribution normale

Considérons la distribution de probabilité gaussienne centrée sur µ = 0 et d’écart-type σ.
La fonction caractéristique est alors donnée par :

ϕx(t) =
∫ +∞

−∞
eitx′ 1

σ
√

2π
e

−x′2
2σ2 dx′ soit ϕx(t) = e

−σ2t2/2
2 (39)

par le calcul habituel de la transformée de Fourier d’une fonction gaussienne. Par développement
en série, on obtient alors :

ϕx′(t) =
∞∑

k=0

(−1)k σkt2k

2kk
(40)

On voit ainsi que tous les moments d’ordre impair sont nuls

〈x′2p+1〉 = 0

tandis que ceux d’ordre pair valent :

〈x′2p〉 = σ2pC2p avec C2p =
(2p)
2p p

.

Grâce à cette expression, on retrouve la variance de la distribution 〈x′2〉 = σ2. On a de
même 〈x′4〉 = 3σ4 de sorte que :

〈x′4〉
〈x′2〉2

= 3 .

Cette dernière relation est souvent considérée comme la signature d’une distribution gaussienne,
lorsqu’on considère une distribution de probabilité P (x) qui est au départ inconnue.
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B Le quinconce de Galton ou la “planche à clous”

Une expérience élémentaire permet de visualiser la limite gaussienne d’un phénomène aléatoire.
Sur un plan incliné, on plante en quinconce des clous de sorte qu’ils soient régulièrement espacés,
en les disposant sur des lignes horizontales parallèles (figure 25). À la base du plan incliné,
se trouvent des compartiments identiques, séparés par des cloisons qui prolongent les clous
situés à la base du quinconce. On place sur la ligne supérieure une bille dont le diamètre est
sensiblement égal à la distance entre deux clous voisins. Depuis cette position initiale, la bille
va descendre en passant à gauche ou à droite de chaque clou rencontré avec la probabilité 1

2 ,
jusqu’à ce qu’elle tombe dans l’un des compartiments à la base du quinconce. Lorsqu’on répète
cette petite expérience avec un grand nombre de billes, les billes accumulées dans les différents
compartiments forment un histogramme dont l’enveloppe se rapproche de plus en plus d’une
courbe en cloche. On trouvera sur le web 33 de très nombreuses simulations de cette expérience,
dont le physicien n’aura pas manqué de remarquer le lien avec le problème de la marche au
hasard à une dimension.

Figure 25: Expérience du “quinconce” ou “planche” de Galton telle qu’on peut par exemple la voir à la Cité

des Sciences (a) ou sous une forme moins sophistiquée (b).

D’un point de vue plus mathématique, ce dispositif illustre la convergence de la binomiale
B(1

2 , n), correspondant à n tirages indépendants d’une pièce de monnaie non biaisée, vers une
loi normale, montrant ainsi comment une succession de processus élémentaires, indépendants les
uns des autres, donne un effet final dont l’histogramme de probabilité tend vers une distribution
normale. Nous pouvons également justifier ce résultat de manière élémentaire. À chaque choc
de la bille contre un clou, elle a une probabilité 1

2 d’aller à gauche (∆x = −a) ou à droite
(∆x = +a). Si nous notons x la variable aléatoire qui représente la position horizontale de la
bille, sa fonction de distribution est :

f(x) =




1
2 si x = +a
1
2 si x = −a
0 si x 	= +a − a

en choisissant de prendre la position du clou comme origine des axes. Par conséquent :

E(x) =
1
2
× (−a) +

1
2
× (+a) = 0

V(x) = E([x − E(x)]2) =
1
2
× (−a − 0)2 +

1
2
× (+a − 0)2 = a2 .

33Par exemple http://www-sop.inria.fr/mefisto/java/tutorial1/node11.html.
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Si nous nous intéressons maintenant à la position de la boule après N chocs, son abscisse est
une variable aléatoire

X =
N∑

i=1

xi

dont la fonction de distribution fN (x) est celle de la somme de N variables aléatoires identiques
xi d’espérance mathématique E(x) = 0 et de variance V(x) = a2. Le théorème de la limite
centrale nous dit alors que cette fonction de distribution se comporte pour N � 1 comme une
loi normale :

fN (X) � 1
σ
√

2π
e−X2/2σ2

avec σ2 =
N∑

i=1

V(xi) = Na2 .

La répartition que l’on matérialise en envoyant un grand nombre de billes qui vont venir
s’accumuler dans les différentes colonnes a donc pour limite la fonction

f∞(X) =
1

Na
√

2π
e−X2/(2Na2) .

Là encore, le lien avec la marche au hasard a une dimension est transparent. Le lecteur intéressé
peut également s’amuser à retrouver ce même résultat en considérant les chemins parcourus par
une bille et en évaluant les probabilités que la bille, partant de X = 0 arrive à une position X
donnée.

Pour la petite histoire, ce dispositif fut imaginé par Sir Francis Galton (1822–1911), qui
vécut à l’époque victorienne et fut l’un des pionniers des études statistiques. Ce scientifique,
qui commença sa carrière par l’exploration en 1844 du Nil blanc et du sud-ouest de l’Afrique,
aborda tout au long de sa vie de nombreux sujets, avec à chaque fois la volonté de quantifier
l’objet de ses études. Séduit par la théorie de l’évolution de son cousin Charles Darwin, il
voulut la transposer à l’espèce humaine et entama des études pionnières sur l’intelligence hu-
maine, qui sont à l’origine des tests psychologiques. Convaincu que la prééminence de différents
domaines était due uniquement à des facteurs héréditaires, ses idées qui sont fortement marquées
par l’eugénisme, influencèrent cependant le développement des méthodes statistiques. On lui
attribue en particulier l’origine du concept de corŕelation entre deux populations et d’analyse
de régression. Galton s’était également amusé à compliquer son dispositif, en interrompant la
chute des billes à un niveau intermédiaire. Les billes sont alors recueillies dans une première
série de bacs, où elles dessinent une première distribution normale d’écart-type σ′. On rouvre
ensuite les bacs séparément et on peut constater que d’une part, chacun des bacs engendre une
distribution normale, de même écart-type σ′′ et que d’autre part, la réunion de toutes ces petites
distributions conduit à une grande distribution normale d’écart-type σ > σ′. On vérifie ainsi
la propriété de stabilité des variables aléatoires gaussiennes : si l’on compose deux variables
gaussiennes stochastiquement indépendantes, on obtient de nouveau une variable gaussienne.

Pour démontrer ce résultat, considérons deux variables gaussiennes x1 et x2 indépendantes,
caractérisées par leurs valeurs moyennes µ1 et µ2, ainsi que par leurs écarts-types σ1 et σ2.
Posons X = x1 + x2 ; la fonction caractéristique de cette nouvelle variable aléatoire va alors
s’écrire :

ϕX(t) = 〈eitX〉 = 〈eit(x1+x2)〉 = 〈eitx1〉〈eitx2〉
de sorte que

ϕX(t) = ϕx1(t)ϕx2(t) = eit(〈x1〉+〈x2〉) e−
(σ2

1+σ2
2)t2

2 .

Nous voyons ainsi que X correspond à une variable aléatoire gaussienne avec comme paramètres :

〈X〉 = 〈x1〉 + 〈x2〉 et σ2 = σ2
1 + σ2

2 .

On notera que ce résultat peut être immédiatement généralisé à la somme de plusieurs
variables aléatoires gaussiennes.
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C À propos de la variance d’échantillon

Dans cette annexe, nous allons montrer que la variance d’échantillon s2, définie par l’Éq.(4.1.3),
correspond à un paramètre qui, dans la limite d’un grand nombre d’échantillons de mesures {xi},
donne en moyenne la vraie variance σ2 de la distribution de probabilité associée à la mesure de
la grandeur x. Calculons ainsi :

〈s2〉 =
1

N − 1

N∑
i=1

〈(xi − m)2〉

=
1

N − 1

N∑
i=1

〈(xi − µ + µ − m)2〉

=
1

N − 1

[
N∑

i=1

〈(xi − µ)2〉 − 2
N∑

i=1

〈(xi − µ)(m − µ)〉 +
N∑

i=1

〈(m − µ)2〉
]

. (41)

Nous reconnaissons sans difficulté le premier et le troisième terme dans cette somme :

N∑
i=1

〈(xi − µ)2〉 = Nσ2 et 〈(m − µ)2〉 =
σ2

N
. (42)

Nous devons calculer le deuxième terme, que nous pouvons écrire à partir de la définition de la
valeur moyenne d’échantillon m :

N∑
i=1

〈(xi − µ)(m − µ) =
1
N

N∑
i=1

N∑
k=1

〈(xi − µ)(xk − µ〉〉 .

Dans cette expression, la seule contribution non nulle correspond à i = k, d’où :

N∑
i=1

〈(xi − µ)(m − µ)〉 =
1
N

N∑
i=1

〈(xi − µ)2〉 = σ2 (43)

En reportant les expressions (42) et (43) dans l’Éq.(41), nous obtenons finalement la valeur
moyenne de la variance d’échantillon s2 :

〈s2〉 =
1

N − 1

(
Nσ2 − 2σ2 + N

σ2

N

)
soit 〈s2〉 = σ2 CQFD . (44)


